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Before you begin

5is learner guide is based on the unit of competency BSBITU304 Produce spreadsheets, 
Release 1. Your trainer or training organisation must give you information about this unit 
of competency as part of your training program. You can access the unit of competency and 
assessment requirements at: www.training.gov.au.

How to work through this learner guide
5is learner guide contains a number of features that will assist you in your learning. Your 
trainer will advise which parts of the learner guide you need to read, and which practice 
tasks and learning checkpoints you need to complete. 5e features of this learner guide are 
detailed in the following table.

Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across content that 

is confusing, make a note and discuss it with your trainer. Your trainer 

is in the best position to offer assistance. It is very important that you 

take on some of the responsibility for the learning you will undertake.

Examples and case 

studies

Examples of completed documents that may be used in a workplace 

are included in this learner guide. You can use these examples as 

models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of 

workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills and knowledge 

into action. Your trainer will tell you which practice tasks to complete.

Video clips Where QR codes appear, learners can use smartphones 

and other devices to access video clips relating to the 

content. For information about how to download a QR 

reader app or accessing video on your device, please visit 

our website: www.aspirelr.com.au/help

Summary Key learning points are provided at the end of each topic.

Learning checkpoints There is a learning checkpoint at the end of each topic. Your trainer will 

tell you which learning checkpoints to complete. These checkpoints 

give you an opportunity to check your progress and apply the skills and 

knowledge you have learnt.
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Foundation skills
As you complete learning using this guide, you will be developing the foundation skills 
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 
skills and the employability skills required for participation in modern workplaces and 
contemporary life.

5e following table outlines speci<c foundation skills noted for your learning in this 
learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises and interprets numerical and textual information 

to determine organisational and task requirements

Writing  • Inputs numerical and key reporting information when 

creating and �nalising spreadsheets and uses format, layout, 

style guides and standard naming conventions to organise 

data according to purpose and audience

Oral communication  • Participates in exchange of information to determine whether 

formulae utilised produce result required

Numeracy  • Uses mathematical equations to create simple formulae and 

validate numerical data

Navigate the world of work  • Recognises and follows explicit and implicit protocols and 

meets expectations associated with own role

Interact with others  • Collaborates with others to achieve joint outcomes

Get the work done  • Uses advanced features within applications to address 

routine and complex work tasks
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Before you begin

What do you already know?
Use the following table to identify what you may already know. 5is may assist you to work 
out what to focus on in your learning.

Topic Key outcome Rate your con�dence 

in each section

Topic 1 Prepare to use 

spreadsheets

1A  Use safe work practices  Con�dent

 Basic understanding

 Not con�dent

1B  Minimise wastage  Con�dent

 Basic understanding

 Not con�dent

1C  Identify spreadsheet task 

requirements
 Con�dent

 Basic understanding

 Not con�dent

Topic 2 Design a 

spreadsheet

2A  Design a spreadsheet to suit the 

purpose and requirements of the 

task

 Con�dent

 Basic understanding

 Not con�dent

2B  Design a spreadsheet that is 

understandable and attractive
 Con�dent

 Basic understanding

 Not con�dent

2C  Use style sheets and automatic 

functions
 Con�dent

 Basic understanding

 Not con�dent

Topic 3 Create a 

spreadsheet

3A  Enter, check and amend data  Con�dent

 Basic understanding

 Not con�dent

3B  Format a spreadsheet  Con�dent

 Basic understanding

 Not con�dent

3C  Use and test formulas and 

functions
 Con�dent

 Basic understanding

 Not con�dent

3D  Overcome problems with 

spreadsheet design and production
 Con�dent

 Basic understanding

 Not con�dent
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Topic Key outcome Rate your con�dence 

in each section

Topic 4 Produce simple 

charts

4A  Select appropriate chart type and 

design
 Con�dent

 Basic understanding

 Not con�dent

4B  Create charts  Con�dent

 Basic understanding

 Not con�dent

4C  Modify charts and layout  Con�dent

 Basic understanding

 Not con�dent

Topic 5 Finalise 

spreadsheets

5A  Preview, adjust and print 

spreadsheets
 Con�dent

 Basic understanding

 Not con�dent

5B  Meet data input time lines and 

quality requirements
 Con�dent

 Basic understanding

 Not con�dent

5C  Name and store spreadsheets and 

exit applications safely
 Con�dent

 Basic understanding

 Not con�dent
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Topic 1 
Prepare to use spreadsheets

A spreadsheet is a very useful computer application that makes it easy to carry out repetitive 
tasks involving numbers. Organisations use spreadsheets to store and calculate numerical 
data such as <nancial statements or product pricing information. Setting up a spreadsheet is 
a simple form of computer programming. Most people in business, or working in an o=ce, 
will be expected to use and produce spreadsheets.

Once you have created a spreadsheet, you need to format it to make the information it 
contains easy to understand. When formatting a spreadsheet you may need to ensure the 
spreadsheet complies with the organisation’s style guidelines.

In this topic you will learn how to:

1A Use safe work practices

1B Minimise wastage

1C Identify spreadsheet task requirements
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Workplace safety is everyone’s responsibility. Employers and employees must make an active 
contribution to ensuring their workplace is safe. Hazards need to be identi<ed and risks 
assessed to reduce injury in the workplace. If you are working at a computer for an extended 
period each day, your workstation must be comfortable and designed for you to carry out 
your tasks e=ciently. You will need to organise your work so that you are not doing a 
repetitive task for a long time. You should also take time to stand up and stretch. 

Another consideration in the workplace is to use resource conservation techniques to 
prevent wastage. Most organisations 
require staB to follow resource-saving 
procedures such as turning oB lights 
in unused rooms and recycling 
paper. You need to be aware of any 
conservation eBorts made by your 
organisation.

Workplace 
safety legislative 
requirements
All work health and safety (WHS) 
legislation requires employers 
to provide a safe workplace and adequate training and supervision, while controlling 
workplace hazards and risks. You must work in line with legislative requirements, 
regulations, Australian and industry standards, and the relevant codes of practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe and 
healthy, such as:

• managing risks to health and safety

• promoting and maintaining the health, safety and welfare of people at work

• protecting people at work from injury and illness, including psychological injury

• protecting the health and safety of the public in workplaces

• consulting workers and encouraging participation in maintaining WHS

• providing rehabilitation and maximum recovery for injured workers.

WHS policy 
All workplaces in Australia are required to have a WHS policy that describes the 
organisation’s responsibility for the health and safety of its employees. 5e policy should 
include the organisation’s goals and objectives regarding WHS and a general set of 
guidelines related to health and safety in the workplace.

5e WHS policy will help you ful<l your duty of care as a worker for the organisation.

1A Use safe work practices
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WHS procedures
WHS procedures are instructions developed to ensure all employees work safely and 
eBectively. In the context of working in an o=ce and using a computer workstation, the 
following information should be contained in an organisation’s WHS procedures.

Information contained in WHS procedures includes:

• workstation ergonomics

• standard safety precautions and housekeeping

• safe handling of hazardous substances (e.g. cleaning products)

• emergency and <re drills

• hazard identi<cation and risk control

• manual handling

• emergency contact numbers, including local doctors and hospitals

• location of <rst-aid equipment and <rst-aid o=cers.

WHS regulations 
5e WHS legislation of each state or territory is supported by regulations and codes of 
practice. 5e WHS regulations support the legislation by outlining speci<c workplace health 
and safety requirements that must be addressed.

5e Model WHS regulations, which provide a framework that most states and territories 
have adopted, have speci<c requirements for hazardous manual tasks that must be 
addressed. 5ese requirements are summarised below.

Manage risk

A person conducting a business or undertaking must manage risks to health and safety 

relating to a musculoskeletal disorder associated with a hazardous manual task, in 

accordance with guidelines for managing risks to health and safety.

Control measures

In determining the control measures to implement, the person conducting the business 

or undertaking must have regard to all relevant matters that may contribute to a 

musculoskeletal disorder, including:

 • postures, movements, forces and vibration relating to the hazardous manual task

 • the duration and frequency of the hazardous manual task

 • workplace environmental conditions that may affect the hazardous manual task or 

the worker performing it

 • the design of the work area

 • the layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of persons, animals or things involved in carrying 

out the hazardous manual task.
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Code of practice: hazardous manual tasks
5e WHS regulations determine that it is a legal requirement for the person conducting a 
business or undertaking (PCBU) and workers to address hazardous manual tasks in the 
workplace. A PCBU has a broad de<nition that includes both employers and supervisors.

5e code of practice for hazardous manual tasks was developed to provide guidance 
on how to manage risks associated with those manual tasks with the potential to cause 
musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own 
set of procedures to manage the risk of MSDs.

5e hazardous manual tasks code of practice helps PCBUs and workers to:

• identify hazardous manual tasks

• assess the risks

• control the risks

• review the control measures.

Musculoskeletal disorders
MSDs come about in two main ways:

• Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through 
repeated or continuous use of the same body parts, including static body positions

• Sudden damage caused by strenuous activity or unexpected movements, such as when 
loads being handled move or change position suddenly

5e repetitive movements and sustained body position associated with entering data into a 
computer is regarded as a hazardous manual task and puts the operator at risk of developing 
an MSD. 

MSDs may include conditions such as: 

• sprains and strains of muscles, ligaments and tendons

• back injuries, including damage to the muscles, tendons, ligaments, spinal discs, nerves, 
joints and bones

• joint and bone injuries or degeneration, including injuries to the shoulder, elbow, wrist, 
hip, knee, ankle, hands and feet

• nerve injuries or compression (e.g. carpal tunnel syndrome)

• muscular and vascular disorders as a result of hand-arm vibration

• soF tissue hernias

• chronic pain.
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Standard precautions
Your workplace may need you to use standard 
precautions, particularly work practices related to the 
prevention of repetitive strain injuries (RSIs). 5ese 
include ergonomic practices, workstation design, enforced 
breaks and exercise routines.

Workers in an o=ce environment follow standard 
precautions when using a computer workstation. 
However, research on sitting has demonstrated that 
other precautions also need to be considered, such as 
the use of standing workstations, to ensure that injuries 
are prevented. It is important that you carefully follow 
any standard precautions that are prescribed for your 
workplace.

Equipment and systems 
safety checks
An important part of your daily work routine is to check the various systems and equipment 
you will use during the day to make sure they are in correct working order. Your workplace 
policies and procedures should include the steps to follow. You may need to perform this 
procedure at the start of your working day or at speci<ed intervals during the day.

Workstation safety procedure/checklist:

• Seat is positioned in front of your computer and you can reach your keyboard 
comfortably.

• Computer monitor is positioned out of direct sunlight and at the correct height. 

• Environment is dust-free as dust can aBect the monitor or central processing unit of a 
computer.

• Cables are secured so no-one trips over them.

• Blinds and window coverings are used to reduce glare and heat at your workstation.

• Temperatures don’t exceed 26°C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace
5e aim of ergonomics is to reduce the risk of accidents, injury 
and ill health by applying safe work practices. Ergonomics is 
about creating comfortable working conditions by adapting 
workstations, tools and equipment to an individual worker’s 
needs. It also improves performance and productivity in the 
workplace. Ergonomics covers all aspects of working, from 
physical stresses such as sitting at a workstation all day  
to environmental factors such as noise, air-conditioning  
and lighting.
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Set up your workstation
A workstation includes a computer, screen, keyboard, mouse, desk and chair. How your 
workstation is designed can aBect your health and wellbeing. Several physical problems can 
result from poor workstation design; for example, lower back strain may result from sitting  
in a chair that does not support your back. Below are some guidelines for setting up your 
workstation to be ergonomically e=cient.

Chair

Adjust your chair height so that your feet are �at on the �oor, your 

thighs are horizontal and your lower legs are vertical to the �oor.

Adjust the backrest by raising it to the maximum height and 

then lower it until it �ts the curve of your lower back. If this is not 

comfortable, lower it another couple of centimetres. Continue this 

until a comfortable position is found. The backrest should support 

your lower back.

The backrest may also be adjusted backwards and forwards. 

When seated in your usual working position, move the backrest 

until it exerts a gentle pressure on your lower back. Make sure 

there is at least two centimetres of space between the front of the 

seat and the back of your knees. Armrests should be positioned so 

that they do not interfere with carrying out your tasks.

Desk

When you sit at your desk, the surface should be just below your 

elbow height. If your desk is not height-adjustable, try to raise your 

chair so you are sitting at the correct height, and use a footrest to 

make up the difference. If your desk is too low, you may be able to 

extend the legs. You should have plenty of leg space underneath 

your desk. Don’t clutter the space with bags and bins, as your 

legs may become cramped and your posture twisted. Position any 

equipment or materials you use so that you can reach them easily 

without twisting. For example, stationery items you frequently use 

should go in the top desk drawer, and your keyboard and screen 

should sit directly in front of you to avoid having to angle or twist 

your body.
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Keyboard

The angle of your keyboard can be adjusted to suit your comfort 

level by moving the supports underneath it. Place the keyboard as 

close as possible to the front of your desk. Don’t place documents 

between yourself and the keyboard, as stretching will eventually 

cause muscle strain in your arms, shoulders and neck. While 

typing it is best not to rest your wrists, as they should not be bent 

up, down, or to the side. The knuckle, wrist and top of the forearm 

should form a straight line. Wrist supports or rests give you a place 

to rest your hands only when pausing from typing, not while you 

are typing. Do not pound the keys; use a light touch. Leave enough 

room on your desk to put the keyboard out of the way when you 

are not using it.

Mouse

Place the mouse and mouse mat directly beside your keyboard on 

the side you prefer. If you use the mouse frequently, you could try 

to alternate sides. You will be surprised at how easy this becomes 

with practice. Your wrist should be straight, and the desk should 

support the weight of your wrist, not your arm. Try to keep your 

wrist �at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not 

using it.

Screen

Once you have adjusted your chair and desk, you can position 

your screen. Adjust it so that the top of the screen is level with or 

slightly lower than your eyes. If you can’t adjust the screen to the 

correct height, place the screen on a platform.

The screen should be at least 50 centimetres or an arm’s 

length away from your seated position to minimise radiation 

exposure; however, you should always adjust the position of the 

screen to suit you. It is best to position the screen so that you 

can clearly read the text without leaning forward, twisting your 

neck, or looking too far upwards. Also take surrounding factors 

into consideration, such as re�ection, glare and shadow, when 

positioning your screen.
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Workstation features
5e features of an ergonomic workstation are highlighted in the diagram below. Some 
features of the workstation may vary depending on the type of computer work being 
performed. Graphic work may require the use of a pen tool, and multiple monitors are 
commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 

degrees to the horizontal. 

Centre of screen Minimise screen re�ection and glare by using an anti-glare �lter.

Bottom of screen Place a document holder beneath or beside the screen at the 

same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and 

your legs.

Below knee Ensure there is clearance between the front edge of the seat and 

the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your 

back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a �ve castor base.
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Desktop layout

Items on your desk, including equipment and resources, should be arranged within 
easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate most of 
the time

• the maximum reach zone – further away, but still close enough to reach comfortably

• the outer reach zone – where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard, 
are close to you. Intermittently used objects, such as your phone, should be out of the way 
but still within easy reach. Other resources used less frequently, such as in- and out-trays, 
should be in the outer reach zone.

Adjust your equipment and posture
When your posture is poor, you may suBer from aches and pains. Spending a long time in 
the same position can put stress on your body and this can be made worse if you are in an 
uncomfortable or poorly supported position. 5ese symptoms may start out very slight, but 
if you continue to use poor posture they may get worse and become intolerable. 5ey may 
result in cumulative stress given the constant stress on your muscles, nerves or tendons. 
When setting up your workstation, you need to make sure your posture will not cause you 
pain or discomfort. 5e equipment you use needs to be adjusted to suit your body shape and 
size, and the tasks you are doing.

You have already looked at adjusting your screen and chair. 5ere are other o=ce tools that 
can help your posture. 5ese include the following items.
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Document holders

Document holders are designed to 

hold papers and reference material in 

a convenient position for viewing. Place 

your document holder in the correct 

position. If it is below the screen or too 

far off to the side, each time your eyes 

look from one source to the other, your 

pupils have to adjust. Doing this for long 

periods of time can cause headaches 

and eyestrain. Place the document 

holder at a similar level, angle and 

distance as the screen to avoid having 

to shift eye focus.

Angle boards

Angle boards allow the user to maintain 

correct posture when reading, by 

reducing the angle between the work 

surface and the vertical posture. 

Adjustable to a suitable height 

and angle, these supports enable 

comfortable reading with the neck 

correctly positioned. Try to keep your 

neck as straight as possible when you 

are reading.

Footrests

A footrest may be necessary if you can’t 

place your feet comfortably on the �oor. 

Footrests allow your feet to rest at the 

correct height and on a tilting angle, 

which prevents strain on the lower 

back. 

Headsets

If you use a telephone for long periods 

of time, it is a good idea to use a 

headset. A headset will keep your neck 

straight and your arms free. Headsets 

prevent you from bending your neck to 

support the telephone handpiece.

Home o5ce
Communication technology and organisational policies to maintain a sustainable work–life 
balance are creating opportunities for more Lexible working arrangements. 5is means that 
more employees are working from home o=ces or in other remote o=ce locations. Many 
bene<ts can be derived from Lexible working arrangement for employers and employees, 
but there is still a responsibility for all parties to make sure that home and remote o=ces use 
ergonomic practices and follow WHS requirements.

Hot desking
Hot desking is an o=ce organisation system that is used in some workplaces where 
workstations are not assigned to an individual worker. Workstations may be used by 
multiple workers during diBerent time periods or shiFs. 

5e motivation behind hot desking is primarily the cost savings achieved by setting up 
fewer workstations in workplaces where not all the workers are in the o=ce at the same 
time, or not in the o=ce for long periods at a time. 

Another common adaptation of hot desking is where work stations are assigned to 
individual workers, but need to be readily available for other workers to access based on 
daily work requirements, such as a group of people coming together to work on a  
speci<c project.
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WHS and workplace culture considerations with hot desking

 • It is common for workers to want their own space. Consequently, they may tend to 

choose one location and stick to it.

 • It can take extra time each day to set up a work station for ergonomic and work 

ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on keyboards 

and desk surfaces.

 • Workstations need to be tidied appropriately in readiness for the next user. This can 

also involve some cleaning.

Standing desks
Sitting at a desk for long periods of time has many 
negative health impacts. It is claimed that the negative 
eBects of prolonged sitting cannot be counteracted by 
regular exercise and that the only way to eliminate this 
problem is to avoid sitting as much as possible. 

5ese negative health impacts can be overcome through 
the use of standing desks. Standing provides a greater 
opportunity for your body to move and adjust and 
involves more muscular activity than sitting.

Some of the health bene<ts from standing include:

• alleviating back pain and other repetitive stress 
injuries by greater use of core back muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood clots, which 
can be caused by prolonged sitting.

Standing desk ergonomics
Using a standing desk for hours on end requires you to adapt. It is recommended that you 
start using a standing desk gradually by alternating between sitting and standing. You may 
experience sore feet, tired legs and fatigue at <rst. Wear comfortable shoes and use an anti-
fatigue Loor mat.

An ergonomically designed standing work desk means you can maintain correct posture 
while working. 

Position arms at 90 degrees when typing/standing.

Place the computer screen at eye-level and tilting it slightly upwards.

Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight. 
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Monitor environmental factors
Environmental issues in the workplace include lighting, noise control and air quality. If 
the environment of your workplace is not monitored and controlled, you may suBer from 
headaches, fatigue, hearing loss or eyestrain.

Light

Good lighting is essential for a safe and hazard-free workplace. You need to see things 
clearly to work eBectively. Simply shiFing the screen slightly, adjusting blinds, altering the 
brightness settings on the screen and using desk lamps can avoid many light hazards. Try 
to use natural sunlight if the o=ce layout can accommodate this. If not, keep bulbs and 
<xtures clean, focus light on your task and use Luorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:

• glare – a computer screen positioned in front of a bright window can be di=cult to see

• Lickering lights – a Luorescent light may malfunction, causing annoyance, irritation 
and nausea

• inadequate or dim light – reading in dim light causes eyestrain

• reLections – sunlight reLecting on a screen can make it di=cult to read

• shadows – shadows shiFing across your work area can cause you to sit with bad posture 
in order to read your work.

Noise

Noise can include any annoying or disturbing sound. Excessive noise around heavy 
machinery or equipment can cause permanent hearing loss. Noise is a problem if it disturbs 
people, distracts them, interferes with communication, causes people stress or generally 
interferes with their work.

Many o=ces are open-plan in design, oFen with employees seated close to each other and 
divided by partitions at chest or head height. 5ink about noise levels when you set up your 
workstation. It should be possible for people in open-plan o=ces to have some privacy when 
they are on the telephone and carrying out their day-to-day activities.

Noise in the o=ce can come from:

• machines (photocopiers, fax machines, printers)

• other equipment (telephones, paging systems, music)

• background noise (liFs, air-conditioning, tra=c)

• people talking.

Noise management

Noise can also be a problem outside o=ce environments, such 
as on factory Loors, at construction sites or near airports. You 
may have to wear ear protection if you are required to work in 
excessively noisy areas.

5ere are many ways that problem noise can be controlled in the workplace. Noisy machines 
can be put in a separate room or area. Sound-absorbent materials such as carpet and 
partitions can be installed or arranged to deLect and absorb noise. 5e volume level on your 
telephone’s speaker can be adjusted.
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Remember that noise is only a hazard when it is stopping you from working productively, 
comfortably and safely. Many people prefer to work with low levels of noise rather than 
complete silence.

Air

Air-conditioned o=ces do not have fresh air from open windows. 5is can cause problems 
for some people.

O=ce workers frequently complain of being too hot or too cold. If a person’s desk is near an 
air-conditioning outlet, the area around their desk can be much colder than elsewhere in 
the o=ce. 5ey can also suBer from dry and itchy eyes. Report such hazards to the relevant 
person. 5is situation can usually be corrected by adjusting air-conditioning Low.

Organise your work
Having a well-planned workstation and comfortable surroundings is pointless if you don’t 
organise your work in a way that prevents discomfort or pain. Make sure you plan your 
daily tasks so that you aren’t doing repetitive work for long periods of time. Make sure you 
take rest breaks and exercise regularly.

Positive work organisation includes:

• a mixture of repetitive and other activities

• rest periods

• exercise breaks.

Vary your activities

Your work role may involve several diBerent tasks. Some tasks may be repetitive, such as 
typing up reports or entering data. If you are able to vary the tasks you carry out each 
day, this will help prevent repetitive actions that cause stress to your body. For example, 
if you have to enter a lot of data, break up the repetitive nature of the task by discussing a 
project with a fellow worker, collecting some research from the internet or doing another 
constructive workplace task you are responsible for. WorkLow should be designed to reduce 
the repetitive tasks given to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include tea breaks 
and lunch breaks. During the working day everyone needs to sit down, breathe easily, relax 
and take time to think about something other than work.

Have exercise breaks

When working with a computer, you should have short breaks at regular 
intervals to combat stress and prevent pain and discomfort. As discussed 
previously, using computers for too long without breaks has been associated 
with back and neck pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage others around 
you to try them. Make sure you are relaxed and stretch gently, without 
overstretching. Stop if you feel any pain or discomfort, and remember to 
exercise both sides of your body. Most importantly, breathe deeply and evenly 
throughout the stretch.

v1
3

2
3
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Neck Turn your head gently to look over your right 

shoulder. Hold for 10 seconds. Now roll your 

head forward to look over your left shoulder 

and hold for 10 seconds. Repeat several times.

Shoulders Sitting with a straight back and neck, roll your 

shoulders forward, then back. Repeat several 

times.

Wrists, hands and arms Interlacing �ngers, turn palms upwards. Now 

lift arms over your head and stretch, leaning 

gently to the left and then to the right. Repeat 

movement several times.

Upper and lower back In a standing position place hands in the small 

of the back. Gently arch back and hold for 10 

seconds. Repeat when needed.

Shoulders and arms Stretch your arms above your head, cradle 

your elbow with your hand and gently pull your 

elbow behind your head. Repeat on the other 

side, holding the stretch for 10 seconds.

Eyes Every 20 minutes, look away from the screen. 

Focus on a distant object (more than three 

metres away).
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Work without stress
Here are some tips for working without stress.

Tips to help minimise stress

 • Adjust your chair and desk to suit your body.

 • Position your screen to suit your posture.

 • Adjust other equipment for safe and comfortable use.

 • Reduce excess noise.

 • Ensure you have adequate light.

 • Arrange your desktop so you can access things easily.

 • Take regular breaks from your work.

 • Frequently rest your eyes.

 • Do stretching exercises.

 • Vary your tasks.
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Practice task 1

1. Here is a checklist to follow when setting up your workstation. Go through the points that are 

relevant to you and make any necessary adjustments to your work or study space. You may 

need another person to help you and check your posture. If you are not able to tick some of the 

checkpoints, change your study space or discuss making alterations to your workstation with your 

manager.

Chair

q Is the seat height-adjustable?

q Is it high enough to allow you to sit comfortably over the keyboard?

q Is it stable?

q Does it swivel?

q Is the height of the backrest adjustable and does it tilt backwards and forwards?

q If it has arms, can you still get close enough to the desk and swivel the chair?

q Are your feet �at on the �oor, or are you using a footrest?

q Are you sitting up straight with the backrest �rm against your back?

Desk

q Is it large enough to allow the screen and keyboard to be correctly positioned?

q Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

q Is it high enough to allow your thighs to �t underneath it?

Keyboard

q Can it be tilted to allow you to adjust it?

q Are the symbols on the keys clear and easy to see?

q Is there suf�cient space in front of it to allow you to correctly position your arms?

Screen

q Does the screen have easily adjustable brightness and contrast controls?

q Is the image on the screen stable and �icker-free?

q Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised to avoid 

glare and re�ections and help you keep a natural and relaxed posture?

q Are you sitting far away enough from it for comfort?

continued …
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… continued

2. Describe the possible consequences for an organisation in which employees do not consider 

their physical health.

3. What should a WHS policy include?

4. What should WHS procedures include?

5. Why should you vary the tasks you carry out each day?
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Practise conservation techniques
Conserving resources at work bene<ts not only the 
organisation by reducing costs, but also the planet by 
reducing greenhouse gases and the amount of waste sent to 
land<ll. Most organisations have policies and procedures 
for conserving resources. You can <nd out what these are by 
reading your workplace manual or asking your manager or 
colleagues.

Ways to conserve resources at work include:

• minimising paper wastage

• reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. Consequently, many 
organisations have developed policies for paper usage. 5ese include:

• using both sides of the paper when photocopying

• recycling non-con<dential waste paper in recycling bins

• storing email messages in an electronic folder instead of printing

• reducing the volume of printing where possible

• reusing paper by using blank sides for rough draFs and reusing folders and <les

• using recycled paper or paper from plantation timber for printed documents

• using a recycling service to collect waste paper.

1B Minimise wastage
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Example: o5ce paper

Using the following statistics, consider how many trees are used for of�ce paper.

How many trees are used to produce paper?

 • One ton of uncoated virgin (non-recycled) printing and of�ce paper uses 24 trees.

 • One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

 • One ream (500 sheets) of paper uses six per cent of a tree.

 • One tree makes 16.67 reams of copy paper, or 8,335 sheets.

 • One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a 

tree.

 • One ton of coated, non-recycled higher-end 

magazine paper (used for high quality photographic 

magazines) uses more than 15 trees.

 • One ton of coated, non-recycled lower-end magazine 

paper (used for news magazines and most 

catalogues) uses nearly eight trees.

The statistics in this example are based on US short 

tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com 

Minimise energy use

Wasting energy also costs organisations and the planet a great deal. Many organisations 
have developed policies and procedures to save energy. 5ese include:

• providing training programs on smart energy practices so that employees can practise 
energy e=ciency

• turning oB equipment when not in use

• using power-save functions for equipment

• re<lling toner and ink cartridges from printers.

Resource conservation
Here are some tips for practising conservation.

Resource conservation tips

 • Use the power-save function on printers when they are not in 

use.

 • Print and copy on both sides of the page, where possible.

 • Use recycled paper (paper used on one side) in the 

photocopier and printer for rough drafts.

 • Use recycled paper for telephone messages.

 • Place a recycling bin near the photocopier.
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Practice task 2

Look at the following statements and decide whether you think they are true or false.

1. Screen savers save energy.

2. Turning off computers crashes the hard drive.

3. Re�lled toner or ink cartridges leak everywhere and make an incredible mess.

4. Putting computers into sleep mode when they are inactive saves energy.

5. Printing and �ling all documents in hard copy does not put a high demand on resource 

consumption.
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Nearly every organisation today uses computers,  
hence it is highly likely your work will require you to 
be familiar with several computer applications, 
including programs for creating spreadsheets. 
Organisations use spreadsheets to store and calculate 
numerical data, which can then be used to produce 
such things as charts, graphs, statements and reports.

Many organisations have speci<c requirements about 
how data is stored and the way it is displayed and 
presented. You must be aware of these requirements 
so your spreadsheet meets your organisation’s 
standards. 5ese requirements can relate to how the 
data is entered, stored, presented and produced.

You also need to know the electronic <ling system for storing spreadsheets. 5is is a normal 
part of using any computer application and it is part of workplace protocol. It is important 
to ensure you store your spreadsheet for easy access by yourself and your colleagues.

MicrosoF Excel is a very common spreadsheet application. 5e examples in this learner 
guide are based on Excel 2013. Earlier versions will be similar in how they work, although 
there may be some diBerences in the appearance of the screens.

1C Identify spreadsheet task requirements
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Spreadsheet layout
Before you start entering data you should be familiar with the layout of a spreadsheet.

A spreadsheet is a grid of columns and rows. It has numbers down the side and capital 
letters across the top. 5ere are other items located above and below the grid. You will use 
these in every spreadsheet you create so it is important you understand what they are and 
how to use them. 5e items include: 

• Spreadsheet work area

• Title bar

• Ribbon

• 5e Formula Bar

• 5e active sheet

Spreadsheet work area

A spreadsheet is called a worksheet. Multiple 
spreadsheets are called a workbook. A spreadsheet 
is divided into columns and rows. 5e intersection 
of each column and row is called a cell. 5e current 
cell is shown by a highlighted rectangle. 5is is the 
cell that data can be entered into. To move to another 
cell, click into the required cell. Each cell has a name. 
5e name is simply the letter above the cell and 
the number to its leF. 5e cell name is called a cell 
reference, like a grid reference on a map.
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Title bar

5e title bar holds the name of the workbook. It has the standard minimise, restore and 
close functions of most applications.

Ribbon

Common commands are organised into a series of tabs in what is referred to as the Ribbon. 
5e File tab helps users <nd features related to document handling such as saving, sharing, 
protecting, printing and sending a document.

For each tab, there are groupings of tools; for example, under the Home tab the 
groupings are:

• Clipboard

• Font

• Alignment

• Number

• Styles

• Cells

• Editing

You need to familiarise yourself with the various tools available in Excel 2013. 5e most 
common tabs used are Home, Insert, Page Layout and View.

To learn about the various tools, rest your mouse pointer on the button. A help bubble 
appears that brieLy describes the purpose of the tool.
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The formula bar

5e formula bar displays the current cell reference you are working in. As you become more 
experienced with spreadsheets, you will use the formula bar to make calculations.

The active worksheet

5e active worksheet information is located in the bottom leF-hand corner of the 
spreadsheet. By default, each new workbook contains three blank worksheets. It is possible 
to add or delete worksheets. 

If you wish to rename your active worksheet:

• double-click on the relevant sheet tab 

• type in the new name. 
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Enter data into a worksheet
Spreadsheets have been designed to enable you to 
enter two main types of data – numbers and text. 
Later on we will also see how to enter formulas.

Examples of the types of data that may be 
entered into a worksheet include sales <gures, 
sales projections, market share, budget <gures, 
questionnaire results or text information. Regardless 
of the type of data entered, it will need to be 
formatted in a meaningful and useful way. When 
formatting data to create a report or presentation, it 
is important to ensure that the end product is clear 
and easy to use.

Most organisations will have set standards for the 
way they want spreadsheets produced, including font, font size, worksheet names and colour 
use. When producing spreadsheets you should seek advice and clarify requirements from 
supervisors and colleagues to ensure you are complying with organisational standards  
and designs.

Example: enter data into a worksheet

The following example shows how to enter information into a spreadsheet. The data you will be 

checking represents the monthly income and expenses of Amy’s Booksellers for a year.

1. Open Microsoft Excel 2013.

2. Click into cell C2 and enter the text Amy’s Booksellers.

3. Click into cell A4 and enter the text Month. 

4. Click into cell B4 and enter text Income.

continued …
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… continued

5. Repeat this process across the row and enter the text Expenses, Pro�t and Clear Pro�t into their 

own cells (see illustration to guide you). 

6. Click into cell A5 and enter text January. 

7. You can enter the names for the rest of the months in two ways. 

Type each month into its own cell as shown or you can use the Fill 

function.

8. To use Fill, move the cursor over the little square in the bottom right-hand corner of the cell with 

January in it. The cursor will form the shape of a small black cross.

9. While pressing the left mouse button, drag the small black 

cross (Fill handle) down. You will begin to see the names of 

other months appearing. Keep dragging until you reach the 

cell that says December. 

10. Release the button and Excel will automatically �ll in the 

months for you.

11. Enter the values as displayed in the example under the relevant headings Income and Expenses. 

12. Save your worksheet in a suitable location on your hard drive and name it Amy’s Booksellers.

13. Select one of the numbers you have entered in the Income column. Click into the cell and re-type 

the new number.

14. Save your changes and close your worksheet.
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Make changes to data
At some stage you will need to alter the data you have entered into a spreadsheet. You may 
have typed it in wrongly or you may have new, more up-to-date <gures to use.

Example: make changes to data

The following example shows one way to make changes to data.

1. Click into the cell where the change is required.

2. Re-type the data as required.

3. Click outside the cell. The changes have been made.

4. Save the worksheet to save the changes.

Select multiple cells, columns or rows
You will oFen need to select more than one cell at a time. 5e following information 
outlines several techniques for selecting areas of a spreadsheet.

Select a group of cells by dragging the mouse

Click on the �rst cell in the range you want 

to select. Hold down the left mouse button 

and drag over the required cells. To select a 

single cell, click into the cell. Selected cells are 

highlighted.

Select a row

Click on the row number button. This will 

highlight the whole row. 

Select a column

Click on the column letter button. This will 

highlight the whole column. 
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Select the entire worksheet

Click on the cell in the top left-hand corner 

of the worksheet to the left of column A. 

Alternatively, on the keyboard press Ctrl+A 

together. This will select the whole worksheet.

Select multiple ranges

Select cells using any of the above methods and 

then hold down the Ctrl key while selecting the 

second (or more) range of cells.

Presentation
You want your spreadsheets to be clear and easy to understand and to conform to any 
requirements of your organisation. Many organisations use templates to make it easy to 
produce standard layouts. 5e templates may already have standard worksheet formatting 
such as shading, font formatting, headers and footers, logos, column and row headings and 
prede<ned formulas.

You may just have to enter the data or alter only parts of the layout. A consistent layout for 
documents boosts the image and reputation of the business.

You may be given guidelines or speci<c instructions on how to produce spreadsheets for 
particular purposes. If you are, it’s important to follow them. Clarify instructions if needed 
and ask questions if you are not sure what to do. If you have your own ideas about how the 
content or format of a document could be improved, speak to your supervisor.

Storage
Where you store your spreadsheet depends on who needs the information. When you create 
a spreadsheet you need to save it immediately. You can save it to your personal hard drive or 
to a shared drive on your organisation’s server. A server is a computer, linked by a network 
to other computers, which stores information so other people can use it.

Ask your manager where you should save your spreadsheet so it can be used by whoever 
might need it.
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Folders are a good way to store common documents – as long as you have a meaningful 
naming system for them. Computer folders are similar to those in a manual <ling cabinet. 
To retrieve a document, you need to know which <ling cabinet and drawer, and which folder 
or index it is stored in. Folders should have meaningful names such as product numbers 
– PN134, client numbers – Smith3422, and project titles – Newtech Project. 5e naming 
of spreadsheets is also important for future retrieval. 5e names need to be meaningful. 
Examples of meaningful spreadsheet names include 2010-QTR1 Sales Report, Smith3422 
Jan 10 Client Report. Using names such as Spreadsheet1 or Sales Report1 does not make it 
easy later on when you need to <nd a particular spreadsheet.

File compatibility
In MicrosoF Excel 2013, when a spreadsheet is saved it has the <le extension .xlsx. Previous 
versions of Excel have the <le extension .xls. 5e <le extension tells the computer system 
what type of <le it is and what program to use with 
that <le.

If you are creating a spreadsheet that needs to be 
used by people with an older version of Excel, you 
will need to save the <le in compatibility mode. To 
create a spreadsheet in compatibility mode, select 
the File tab, select Save As, and select Excel 97-2003 
Workbook in the Save as type list.

Ensure you have selected an appropriate drive and 
folder for saving; then in the <le name box type a 
meaningful name for your spreadsheet, and click 
Save. You should do this when you start creating a 
new spreadsheet.

Output
When you start a new spreadsheet, you should think about how you want the spreadsheet to 
present the results, or output, of its calculations. 

Some points about output to keep in mind include:

• Who is going to use the results?

• What are the results that will be useful to them?

• How are they going to use them?

• What format will they want them in? 

• What labels should you put on any number results so people can understand what 
they are? 

• Is the output going to be printed, stored or sent to someone electronically?
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Practice task 3

Read the case study, then answer the questions that follow.

Case study

Josh works as an administrative assistant in a large organisation. One of his duties is to create 

spreadsheets to his manager’s speci�cations. One day Josh is asked to create a spreadsheet 

containing the monthly sales �gures of a selection of products the organisation sells. The 

spreadsheet has to calculate the total takings for each product and then work out a 10 per cent 

taxation charge for each amount calculated.

The spreadsheet must be formatted to organisational requirements and then saved to the 

server in the shared folder for sales. Josh’s manager tells him to name the spreadsheet Product 

Totals.

As well as entering the monthly sales �gures in one column, Josh has to create two more 

columns of information.

1. Describe the information to be held in the two new columns.

2. Decide on names for the two new columns.

3. How does Josh have to format the data?

4. What is the name of the spreadsheet and where will it be stored?

continued …



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

31

Topic 1
Prepare to use spreadsheets

… continued

Read the case study, then answer the questions that follow.

Case study

Phuong works as an administrative of�cer for a local council. She has recently moved into the 

community development department from the rates department and is looking forward to the 

change. Phuong has been asked by her supervisor to create a spreadsheet report summarising 

the number and type of small businesses in the area, and to include a chart that shows the 

clustered locations of the businesses. Phuong is familiar with using spreadsheets and creating 

charts from her time in the rates department. Phuong is not sure how to go about �nding out 

the information to include in the report – does it mean that she has to go out and visit all the 

small businesses? 

Phuong decides to speak with her supervisor to clarify what is required to produce the report. 

Phuong’s supervisor explains that it is a report which is completed on an annual basis, so she 

should be able to access last year’s report from the network drive in the folder 2014-Small 

Business. However, her supervisor is not sure of the spreadsheet name so she will need to have 

a look for it. Her supervisor suggests that she follows the same layout and presentation as last 

year’s report, although she should check that it has the current council logo in the heading. 

Phuong asks her supervisor who the report is for to check output requirements. Her supervisor 

explains it is to be presented at the upcoming managers’ meeting next Friday. Her supervisor 

has asked that she complete a draft of the spreadsheet by Wednesday morning so that he can 

check the report. Once checked, 15 copies of the report need to be produced.

Phuong goes back to her desk and locates last year’s report. She now knows how it is to look. 

She also knows her deadline, the reason for the production of the report and how many copies 

are required. What Phuong doesn’t know is where to get the current data for entry into the 

spreadsheet. She goes back to her supervisor to check. The data is contained in another report 

that was produced by her co-worker last month. That report contains information about all 

the types of businesses in the area (small, medium, large), as well as projections of potential 

businesses in the area. Her supervisor tells her to see Ingrid to check the �le location and 

name. Phuong speaks to Ingrid to get the location of the report. Phuong is now able to use this 

report as her source document for creating the report that she has been asked to complete.

continued …
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… continued

5. What is Phuong’s task?

6. What does Phuong do to clarify task requirements?

7. What additional sources of information were helpful to Phuong in producing the report?

Summary

1. Make sure your workstation and working conditions are safe and healthy so you can 
work comfortably and productively.  

2. Organise your work area and your working day to ensure that you enhance and promote 
a healthy and safe work environment.

3. Practise conservation techniques to try to minimise paper wastage and energy use.

4. When producing a spreadsheet, check requirements for data entry, presentation, output 
methods and quantity. 5is ensures the <nal product meets organisational and task standards.

5. Store spreadsheets in locations that can be accessed by those who need to use them in 
the future. Ensure that spreadsheet names are meaningful so you can easily locate the 
information at a later date.
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5is learning checkpoint allows you to review your skills and knowledge in preparing to use 
spreadsheets.

Part A
All staB have been asked to submit their ideas on promoting a healthy and safe work 
environment within the workplace.

1. Write your ideas on how you or your colleagues could improve work practices in  
terms of:

• workstation design and layout

• using adjustable, ergonomic equipment

• ensuring good posture and work habits

• identifying and reporting potential workplace hazards and risks

• saving energy and other resources.

Learning checkpoint 1 
Prepare to use spreadsheets
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Part B
Read the case study, then answer the questions that follow.

Case study

Selda has recently started work as a marketing assistant with a large car sales business. She 

has been asked to create a draft summary report of all existing customers, the types of cars 

they have purchased and if they are repeat customers. The information is to come from the 

product sales database. This information will be used to select customers for the marketing 

campaign for the newly released family wagon. The report will be used by �ve members of the 

marketing team and seven sales managers. The marketing manager has asked to see a draft 

of the spreadsheet by the end of the week. The spreadsheet is to be stored on the server in the 

product folder PNwagonXXR007. 

Selda knows she needs to abide by organisational requirements for the design and layout.

1. Explain how Selda would identify the following:

• 5e purpose of the spreadsheet

• 5e audience for the spreadsheet

• 5e data source used for data entry

• 5e information to be reported in the spreadsheet

• 5e number of copies of the spreadsheet required

• Where to store the spreadsheet

• How to name the spreadsheet
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2. State four possible organisational requirements that Selda needs to consider when 
preparing the spreadsheet.

3. How would Selda be able to <nd out the presentation requirements for the spreadsheet?
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Designing a spreadsheet means knowing exactly what you need to do, and how to do it, 
before you start building the spreadsheet. 5is planning helps make sure that you don’t 
waste time producing a spreadsheet that doesn’t work properly, is hard to use or doesn’t give 
the information that people need.

You may be able to use prede<ned spreadsheets and automatic functions to save time and 
to make sure your spreadsheets comply with the standards of your organisation. 5ey make 
the task of creating and formatting a spreadsheet easier – saving time and reducing errors.

In this topic you will learn how to:

2A Design a spreadsheet to suit the purpose and requirements of the task

2B Design a spreadsheet that is understandable and attractive

2C Use style sheets and automatic functions
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When producing a spreadsheet you should be guided by the requirements of your 
organisation. It is always important to clarify instructions so you are clear about what is 
needed. If you have your own ideas about how the content or format of a spreadsheet could 
be improved, speak to your supervisor.

Steps in designing a spreadsheet 
Here are some points to consider when you set about designing a spreadsheet. We will look 
at these steps in more detail in the following pages.

Steps in designing a spreadsheet

Appropriateness to required task

Headers and footers

Analysis

Headings

Formulas

Restricting access to parts of the spreadsheet

Functions

Importing and exporting data

Charts

Macros

Formatting

Multi-page documents

Appropriateness to required task

Spreadsheets are used to analyse <gures and present them in a way that is easy for people to 
understand. Always ensure the spreadsheet does what is needed.

It should be easy for people to put data into the spreadsheet, as well as to understand what 
comes out of it.

5ere are <ve main things you need to know before you start planning, or designing, your 
spreadsheet:

• 5e purpose of the spreadsheet

• Who will use the spreadsheet

• 5e type of information that needs to go into the spreadsheet (the inputs)

• 5e information that the spreadsheet needs to produce (the outputs)

• What the spreadsheet has to do with the inputs in order to produce the outputs (the 
processing)

2A Design a spreadsheet to suit the purpose 
and requirements of the task
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Analysis

Some typical ways a spreadsheet can make analysis of 
data quick and easy are:

• calculating the average of some numbers

• calculating the totals of lists of numbers

• working out percentages

• calculating simple and compound interest using 
formulas.

You need to know how to get the spreadsheet to do 
these things by putting formulas and functions into 
cells in a way it can process.

Excel uses formulas and functions (built-in formulas) 
to manipulate numbers so you can analyse them in 
whatever way you need.

Formulas

You can enter a formula into any cell. To do this you must start with an = sign, so the 
spreadsheet knows that it is a formula and not something else.

5e most basic operations a formula can do are:

• add using the symbol +

• subtract using the symbol – 

• multiply using the symbol *

• divide using the symbol /

Enter a formula

If you want to add two numbers, follow these steps:

1. Enter one number into a cell, say A1.

2. Enter the other number into a cell, say A2.

3. Type a formula into another cell. For this example, type =A1+A2 into cell A3. (If the = is 
not present, Excel will not recognise the entry as a formula, rather it will assume that it 
is simply a text entry.)

4. When the formula is typed, press Enter. 5e answer to the calculation will be displayed 
in cell A3.

5e formula takes the numbers stored in cells A1 and A2 and adds them. 5e answer is put 
in the same cell where you entered the formula.

If new numbers are typed in A1 and A2, notice that cell A3 now displays the new answer 
automatically when Enter or an arrow key is pressed. You don’t have to type the formula 
all over again. It simply stays there, processes the data from A1 and A2 and records the 
result in A3.

5is is what using spreadsheets is all about. You don’t have to repeat the same calculations 
over and over each time you get new data, as long as you use the cell references of the cells 
containing the data that your formulas and functions will use and not the actual numbers in 
the cells.
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Functions

A function is a formula that is built into the spreadsheet. Functions can save a lot of eBort 
by doing quite complex calculations in one cell. Excel provides functions to do a variety of 
common calculations, such as SUM or AVERAGE. For example, =SUM(B5:B17) adds all 
the numbers in the range of cells from B5 to B17. Functions can be used in Excel to perform 
a variety of mathematical, statistical and <nancial calculations to help you to analyse 
information. Some common functions used in Excel, with examples, are shown in the 
following.

=SUM(range)

Adds the numbers in the cells that are within the range speci�ed in the 

brackets.

Example: provides a total of all assessments the student has completed.

=SUM(B5:E5)

=MAX(range)

Finds the highest value from cells that are within the range speci�ed in the 

brackets.

Example: shows the highest student result from the group.

=MAX(F5:F7)

=MIN(range)

Finds the lowest value from cells that are within the range speci�ed in the 

brackets.

Example: shows the lowest student result from the group.

=MIN(F5:F7)

=AVERAGE(range)

Finds the average of numbers in the cells that are within the range speci�ed in 

the brackets.

Example: shows the average result of all students.

=AVERAGE(F5:F7)

=COUNT(range)

Counts the number of items in the range.

Example: counts the number of results entered for the class.

=COUNT(F5:F7)
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Charts

Charts are a good way to show the results of the 
spreadsheet analysis because they can be grasped 
quickly, without the user having to do too much 
thinking; for example, a ‘pie chart’ or a ‘bar chart’ 
would be good to show what percentage of total 
sales each of several models of cars contributes. To 
show how the temperature in a coolroom varies over 
several weeks, a ‘line chart’ or ‘scatter chart’ would 
be best. By using charts, you save people the trouble 
of having to look at lots of <gures. 

Format

Formatting a spreadsheet means to present the information in the most understandable 
way. You can do things like highlight important text and numbers using bold or italic, or 
underlining or shading. 5e choices are very similar to those available in word processing 
programs. You can also adjust the column width or row height and adjust the alignment 
of the text – centre, right, leF or angle. You can choose how numbers are presented; for 
instance, in currency format, as decimals with a particular number of decimal places, or in 
date format.

Headers and footers

Headers and footers are used to record common information in the margin of the report. 
5e header is at the top of the page, the footer is at the bottom. Headers and footers are 
automatically repeated onto all pages of the spreadsheet report. Headers and footers might 
include the company name and logo, name of report, creation date of report and <le 
reference information. 

Headings

Headings in a spreadsheet are the letters above the columns and 
the numbers beside the rows. 5ese headings are useful because 
they give you an understanding of where you are located within 
the spreadsheet. Some people prefer to work without the headings 
displayed. Headings can be turned on and oB by selecting the Page 
Layout tab and checking or unchecking the Headings View box.

You can also choose whether to print headings.

Displaying or printing headings is useful when you are checking that information has been 
accurately entered, particularly when checking for errors with formulas or functions.
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Restrict access to parts of the spreadsheet

It is possible to limit the sort of data, and the range 
of data, that can be entered into a spreadsheet; for 
instance, only putting numbers in and not letters. 
An unprotected spreadsheet has many places where 
someone could enter data in the wrong place, or 
change a formula and ruin the spreadsheet. You can 
put restrictions on what parts of the spreadsheet 
people can change. 

Import and export data

You may want to bring data into your spreadsheet 
from another application such as MicrosoF Access. 
5is is called importing data. 5e following tools, 
located in the Data tab under the Get External Data grouping, are used to import data.

You would need to import data if the information you require is stored in a customer 
database. You may need to import customers’ contact details, for example.

Exporting Excel data to another application from Excel can be done by copying and pasting 
the required information. You might need to do this if the data needs to be analysed or 
presented in a diBerent way.

Macros

Macros make it easy to do common tasks; for example, if you regularly insert the company 
logo into your spreadsheet, instead of going through all the steps to insert the logo, you 
can design a macro with a short-cut keyboard command. 5en all you have to do is use the 
keyboard command and your logo is automatically inserted. Macros can also be assigned to 
graphics within an Excel spreadsheet.

Multi-page documents

If the report from your spreadsheet is longer than one page, you need to ensure you have 
designed the spreadsheet so the information can be understood regardless of which page 
your audience is reading.
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Practice task 4

Read the case study, then answer the questions that follow.

Case study

Helen has recently taken up a position as an administrative of�cer with a government 

department. Her manager has asked her to compile a spreadsheet report analysing the number 

of people who have travelled overseas in the past year, as well as information on countries 

visited. She has also been asked to ensure that she follows standard guidelines for producing 

the report such as colours, font type and size and the department logo. The report from the 

spreadsheet is to be distributed to media outlets. A graphical representation showing the top-

10 locations for travel is also required.

1. Who is the audience for the spreadsheet?

2. What is the purpose of the spreadsheet?

3. What are the information requirements?

4. What are the elements of spreadsheet design that Helen needs to consider?
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5e spreadsheet should clearly highlight key information by using titles for columns and 
rows, and formatting such as shading, borders and font style. 

Important information, such as the results, should not get lost among other things (such as 
the data that has been entered).

Numbers and text should be aligned within cells in the way that is easiest to read.

Spreadsheet styles and layouts
5e layout and presentation of the spreadsheet 
should project your organisation’s image. Many 
organisations use spreadsheet templates to help 
maintain a standard appearance. 5ese may have 
font formatting, headers and footers, logos, formulas 
and functions, and the title text of the spreadsheet 
already there. It may just be a case of entering names, 
addresses or summary <gures, or altering only parts 
of the content. For example, if you are required to 
produce a monthly report of <nancial information, 
the only diBerence each month will be the <nancial 
data. 5e formulas and overall appearance will be 
the same. Your organisation may have a template set 
up with all the required row and column titles and 
shading, font type and size and so on, and you will 
only need to input the required <gures.

2B Design a spreadsheet that is 
understandable and attractive
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Improve presentation

In MicrosoF Excel 2013, there is an option to apply cell styles to the spreadsheet. 5ese are 
prede<ned styles available for your use. Styles relate to font type, font formatting, number 
formatting, borders and shading. It is as simple as selecting the cells that require the style 
applied, choosing the Home tab, and selecting the Cell Styles button. From here you can 
choose to apply a prede<ned style or create a new style for future use.

You might choose to use diBerent prede<ned styles for row and column titles, the data 
contained in the spreadsheet and summary information. 5e use of styles will add to the 
appearance and overall presentation of the information.

5e following example shows how style choices can be used to improve presentation. 5e 
spreadsheet titles are formatted, and merged and centred across the length of the data. Titles 
are formatted appropriately and end stock <gures are shaded to highlight the end result. 
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Practice task 5

Consider and compare these two spreadsheet examples. 

continued …
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… continued

1. What are the differences between the two examples?

2. Which one is easier to read? Why?
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A style sheet is similar to a template and is used to apply prede<ned information, 
formatting, formulas and functions to a spreadsheet. Style sheets can be protected to ensure 
that users cannot change anything apart from the information they are required to enter.

Several automatic functions may also be used for designing spreadsheets. Automatic 
functions make it easy to create a spreadsheet that is professional and easy to read.

Style sheets and automatic functions are useful tools for ensuring that spreadsheets 
produced by diBerent people in an organisation are consistent in their appearance.

5is is especially important if your spreadsheet is going to appear with others in the same 
document or presentation. 5is consistency improves your professional image and that of 
the organisation as a whole. For example, a covering letter that accompanies a report should 
be consistent in appearance with the report itself. 5e following example illustrates a word 
processing document and a spreadsheet with a consistent appearance.

2C Use style sheets and automatic functions
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Style sheets
A style sheet is a prede<ned spreadsheet that is used as a template. A template can be 
accessed by selecting New from the File tab.  

You can create a template from a blank spreadsheet. A template allows you to create a 
structure for other spreadsheets using common data and formatting options. 

1. To do this, <rstly create the spreadsheet component or structure you want to use.

2. Select the File tab and select Save As. 

3. Give the template an appropriate name, and in the ‘Save as type’ option choose ‘Excel 
Template’. 

If you are working in Excel 2013 and the template is to be used by people who have a 
diBerent version of Excel, you need to choose the option Excel 97-2003 template.
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Borders
Borders are lines applied around a cell or cells. Borders are used to keep certain information 
separate from other parts of the spreadsheet or to highlight the information. 

1. To add a border, select the area where you want the border to apply.

2. From the Ribbon choose the Home tab and select the appropriate Border tool from the 
selection list.
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Headers, footers and page numbers

Headers and footers are used to incorporate information into the margin of a spreadsheet. 
Examples include current date and time, <le reference, and page numbers. 

To insert a header or footer, from the Insert tab, select Header & Footer. You will now be 
able to enter the required information or use the tool buttons to design your header or 
footer. AFer entering a header or footer, the on-screen view is Page Layout. To return to the 
normal view, select the View tab, and select Normal.

Page numbering is commonly used in either the header or footer of the spreadsheet to show 
the number of pages of a spreadsheet, as well as the current page that you are viewing in 
the printed version. To insert page numbers, select Header & Footer from the Insert tab. 
5e Design tab will appear, then you can select the appropriate page numbering tool as 
shown below.

If you are showing both current page number and total number of pages, then you need to 
manually type in ‘of ’ as this is not automated.

Alignment

Text and values align diBerently within the cell by default. Text aligns to the leF, values to 
the right. To adjust the horizontal alignment of data within a cell, select the cell or cells and 
choose the appropriate alignment tool from the Home tab. 

Horizontal alignment options include leF, centred or right.

Alignment of data within a cell can also be adjusted for the height of the cell. 5e automatic 
default is to align the text to the bottom of the cell. To adjust the vertical alignment of data 
within a cell, simply select the cell or cells and choose the appropriate alignment tool from 
the Home tab. Data can be aligned to the top, centre or bottom of the cell. Text can also be 
oriented to be on an angle. 
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Merge & Center tool

Another common tool used to align cells is Merge & Center. 5is is commonly used to align 
a heading across the width of data in the spreadsheet. Look at the following example:

In this example, the headings Henry Lewis Consulting & Co and Sales results have been 
merged and centred across the columns A:G. To perform this action, each row is dealt with 
separately. 

First, the data from cells A1:G1 are selected and then the Merge & Center tool 
 on the Home tab is pressed. Next, the data from cells A2:G2 are selected, 

and then the Merge & Center tool is selected. 5is provides the data with a heading.

Extra space can also be added to the spreadsheet by adjusting the column width and row 
height. 5is can be done by positioning the cursor between either the letters of the columns 
to be widened, or the numbers of the rows to be made taller. A double-headed arrow will 
appear that will enable you to click and drag to adjust the column width or row height. 

When using Merge & Center, the data to be merged across the cells must be in the <rst cell 
selected.

Typeface styles and point size

Many organisations have standard requirements for font type and size. To adjust the font 
type and size, select the cell to be changed and make your selection using the Font tool and 
Font Size tool as shown below.

Automatic functions
Excel 2013 provides a number of automatic functions to quickly perform common tasks. 

Some functions to preform common tasks include:

• Date & Time

• AutoText 

• Proo<ng

• Default settings 

• AutoCorrect

• Styles

• Table headings
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Date & Time

To automatically insert the current date into a cell, 
select the cell and press ctrl+;

To insert the time, press ctrl+shiF+;

To automatically put the current date in a cell within 
the worksheet, you can use the TODAY function: 

=TODAY()

Being an automated entry, it should be noted that as 
the date changes, this will be automatically updated 
to the current date. 

Proo>ng

Proo<ng automates the proofreading process so common errors or entries are easier to 
detect. 5e Proo<ng feature can be customised by clicking the File tab, choosing Options 
and selecting Proo<ng.
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AutoCorrect

AutoCorrect automatically corrects common 
typing errors; for instance, if you were typing the 
word ‘what’, and accidently typed in ‘whta’, Excel 
will correct the error to ‘what’. In most cases, you 
don’t even notice you have made the typing error. 
It is a handy feature, but only works for common 
words. You can customise the list of words you want 
AutoCorrect to <x.

AutoText 

AutoText is a facility that completes text as you type. 
Excel recognises that you may have entered the same 
information previously. For instance, you may be 
typing in locations of retail outlets, such as Sydney, 
Melbourne and Adelaide. Once you have typed in these entries, when you type the data for 
the next entry, Excel will automatically provide an option for you to select from rather than 
retyping. Look at the example below:

In this example, notice that when Melbourne is being typed again, as soon as ‘M’ is typed, it 
automatically completes the text. It is then only necessary for you to press enter to accept it. 
If it is another entry that you are completing – such as Malvern – just continue typing.

Default settings

Default settings are the original settings of the 
spreadsheet. People sometimes refer to the default settings 
as cell entries with no style applied; however, it is a style 
called Normal. 5is style has preset formatting such as 
font type=Arial, font size=12. 5ere is no other formatting 
applied to the Normal style. To adjust data to the Normal 
style, select cells to be adjusted, and from the Home tab, 
go to the Styles group, click on Cell Styles, then select 
Normal .

Default settings also relate to column width. 5e standard 
width of the column is 8.43 characters. If you have 
adjusted the column width and want to return to the 
default setting, select the column you want to adjust, and 
from the Home tab, go to the Cells grouping. A drop-
down menu under the Format icon will allow you to 
adjust the width to the default.
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Styles

In MicrosoF Excel 2013, it is possible to use styles to format individual or groups of cells. 
To do this, select the cells to be formatted by clicking and dragging to highlight them. To 
format using styles, from the Home tab go to the Styles group, then select Cell Styles and 
click on your choice.

Styles apply formatting such as colour, borders, font type and size to the cell.

Table headings

In Excel 2013, it is possible to convert your data into a table. Tables make the information 
easy to work with, as formatting is automatically applied and it is possible to have the titles 
of the table automatically become headings. 5is can be useful for sorting and reviewing 
data. 5e following example demonstrates how data has been converted to a table format 
with headings.

5e table headings have arrows that enable you to quickly sort the data.

To convert data to a table, select the cells by clicking and dragging to highlight them, and 
then from the Insert tab, select Table.
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Practice task 6

1. Create the following spreadsheet and save it as a template named Monthly Consultant Sales 

Report.

Practice using the template. Select the File tab, choose New, and select My Templates. The 

Monthly Consultant Sales Report template should be available for your use, as below.

Here are some of the features you can incorporate into your style sheets:

 • borders

 • page numbers

 • alignment

 • typeface styles and point size.

continued …
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… continued

2. Create the following spreadsheet and apply borders as shown – thin inside borders for key 

information, and a thick outline border for the entire report. Save the �le to an appropriate �le 

location and name it August Car Sales.

From the Insert tab, select the Header & Footer. Insert the current date and current time into the 

footer. This will now be part of the spreadsheet.

Adjust the column width and row height to give more space. Adjust the alignment within cells to 

improve the presentation of the data. Start by centring vertically and horizontally.

3. Using the following information, create a spreadsheet that meets the following requirements:

Font – Arial 14, bold and italic

Titles – shade background in yellow

Border – thick outline

The information is to be used by the �nancial analyst at a meeting to discuss pro�t levels. Save 

the �le to an appropriate location and name it Fashion Excess – stock on hand.

Stock item Quantity on hand Cost per item Retail price per item

Knickerbockers 188 $45 $86

Flower power pants 191 $55 $92

Flare pants 192 $51 $98

Skirts 101 $18 $67

A-line skirts 76 $23 $87

Hot pants 177 $34 $76

continued …
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… continued

4. Practise using AutoText with the following spreadsheet entries.

SOCIAL CLUB RAFFLE WINNERS

1st prize Mary Johansen

2nd prize Helga Smithe

3rd prize Gilbert Goshwig

4th prize Mary Johansen

5th prize Mary Johansen

6th prize Mary Sinclaire

7th prize Gilbert Goshwig

8th prize Gilly Green

9th prize Helga Smithe

10th prize Helen Wilson

Save the �le in an appropriate location with the name Name list. Practise applying different 

styles to the data.

5. Create the following spreadsheet, and convert it to a table with headings. Practise using the 

heading arrows to sort and review the entries. 
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Summary

1. Spreadsheets are used to analyse data and present the results in a clear and 
understandable way.

2. When designing a spreadsheet you need to know its purpose, who will use it and the 
inputs, processing and outputs required.

3. 5e design of the spreadsheet should meet the needs of the person requesting it, as well 
as organisational expectations and standards.

4. You can use formatting, charts and other graphics to improve the readability and overall 
presentation of the spreadsheet.

5. Formulas and functions simplify the processing of data.

6. Automatic features can be used to save time and reduce errors.
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5is learning checkpoint allows you to review your skills and knowledge in designing a 
spreadsheet.

Part A
Workplace learners can either complete this assessment using a spreadsheet that they 
produce in the workplace or use the following scenario to complete the assessment.

Read the scenario, then complete the tasks that follow.

Scenario

Imagine you are working as an administrative of�cer for Eastern Employment Agency. The marketing 

manager asks you to create a spreadsheet to be used as a summary report to promote their 

achievements in work placements. Information is to be presented to show weekly results as well as 

monthly achievements of the past quarter. The weekly information for the report is as follows:

Week 

ending

Client 

numbers 

at start of 

the week

New clients Number 

of clients 

placed in 

work

Number of 

voluntary 

placements

Number 

of paid 

placements

7 January 5038 123 1231 402 829

14 January ? 234 1234 341 893

21 January ? 12 435 123 312

28 January ? 43 1121 455 666

5 February ? 341 341 23 318

12 February ? 121 234 28 206

19 February ? 12 432 231 201

26 February ? 42 123 53 70

5 March ? 411 532 43 489

12 March ? 123 522 234 288

19 March ? 12 100 50 50

26 March ? 234 123 12 111

To comply with your organisation’s requirements you must:

 • insert a header stating the name of the business

 • insert a footer that displays the current date and time

 • insert a background shading – light blue

 • use a thick outline border, and a thinner line for inside borders

 • use bold titles

 • use font type – Arial

 • use font size – 14pt

Learning checkpoint 2 
Design a spreadsheet
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1. Create a report of the weekly results. You need to have the spreadsheet calculate the 
client numbers at the start of each week. 

Use appropriate cell references to complete the calculation. 

Calculate as follows:

• Client numbers at start of week = number at start of previous week + number of new 
clients – number of clients placed in work.

2. Create a monthly summary report as requested by the marketing manager. Use the 
SUM function to calculate summary <gures for each month. 

3. Save the <le to an appropriate location and name it Work placement summary. 

Part B
Read the case study, then complete the tasks that follow.

Case study

Mara works as an employment coordinator for Eastern Employment Agency. She has been 

asked to produce a monthly summary report for the operations manager to present at the next 

management meeting. The report is to show the number of paid-work industry placements. The 

information will be used to analyse market segments. The total �gures for each segment should 

be presented as a pie chart. To comply with the organisation’s requirements Mara must:

 • insert a header stating the name of the business

 • insert a footer that displays the current date and time

 • insert a background shading – light blue

 • use a thick outline border, and a thinner line for inside borders

 • use bold titles

 • use font type – Arial

 • use font size – 14pt

Mara produced the following spreadsheet for the operations manager.
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1. What is the purpose of the spreadsheet?

2. Who is the spreadsheet for?

3. What are the task or information requirements for the spreadsheet?

4. What are the organisational requirements for the spreadsheet?

5. Has Mara produced a spreadsheet that conforms to the organisational and task 
requirements?
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6. What could Mara do to improve the overall readability and appearance of the 
spreadsheet?

7. How would the use of a style sheet have helped Mara?

8. Produce the spreadsheet yourself. Note you will need to use the SUM function to total 
industry segments – use these <gures to produce the chart. Save the spreadsheet to an 
appropriate location. Name it Summary industry paid placements. 

9. What automatic functions did you use in producing the report?
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Previously you have learned how to design, or plan, a spreadsheet. It is important to know 
the purpose of the spreadsheet, who will use it, the inputs and outputs, and the processing 
needed to analyse the inputs and produce the outputs. It is also necessary to check your 
work to ensure it is accurate, and overcome any design Laws that may have arisen in the 
process of creating your spreadsheet.

In this topic you will learn how to:

3A Enter, check and amend data

3B Format a spreadsheet

3C Use and test formulas and functions

3D Overcome problems with spreadsheet design and production
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Several types of data go into a spreadsheet. Once the  
data is in the spreadsheet, you need to check that it is 
correct, and <x any mistakes. Remember the 
acronym GIGO, which means ‘garbage in, garbage 
out’. If you put the wrong data in, you get the wrong 
answers out.

5e diBerent types of spreadsheet data include:

• dates and times

• text

• numbers.

Examples of text data are names, addresses and 
product information. Date and time data can be in 
numerical or text format and can include months, 
days, hours, minutes and seconds. Examples of numbers are quantities, customer numbers, 
pricing, sales <gures and interest rates.

Excel treats data diBerently, depending on whether it is text, number or date/time. 

Dates and times

Dates can be entered in the following formats:

• Day/Month/Year = dd/mm/yyyy

• Month/Day/Year = mm/dd/yyyy

For instance, 12/03/2012 is the 12 March 2012 if the format is Day, Month, Year but it is 3 
December 2012 if the format is Month, Day, Year.

Times can be am and pm or 24 hour. Ten past six in the aFernoon is 6.10 pm or 1810 hours.

Excel 2013 tries to match the formatting with the way the information is 
typed in.

Always con<rm the correct formats for your spreadsheet.

Text 

When entering text, you will notice it is automatically aligned to 
the leF of the cell. You will also notice that if there is no data in the 
adjacent cell, the text will overLow into it.

3A Enter, check and amend data
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View text in the Formula Bar

If there is data in the adjacent cell, the text that is entered will be 
truncated (chopped oB). 

It may appear that the data is lost, but it is still contained in 
the cell. 

A simple way to con<rm this is as follows:

1. Click in the relevant cell.

2. View the cell’s contents in the Formula 
Bar.

Format the cell to wrap text 

To ensure the printed and on-screen versions of the 
spreadsheet show the cell’s full content, you need to adjust the 
width of the cell or wrap the text within the cell. 

Text is commonly used for entries of lists of information such 
as names, addresses, product details, and other descriptive information.

To wrap text in a cell:

1. Select the cells.

2. Use the Wrap Text tool , which is located on the Home tab.

Wrap Text is commonly used for longer entries where you don’t want to adjust the column 
width but want to be able to read all of the information in the cell; for example, address 
details.

Adjusting cell width is explained in the next section on numbers.

Numbers 

When entering numbers, the alignment is to the right of the cell. In most 
cases, if the number is longer than the cell, the width of the cell will 
automatically adjust. 5e number of digits for a value is limited to 15.

Sometimes numbers appear as shown below. 5is occurs 
when the number has too many digits for Excel to deal with, 
so it rounds it oB and puts it in scienti<c notation.

When the cell is not wide enough for a number entry, it is 
<lled with a row of hashtags (#). 5is is a diBerent situation to having too 
many digits.

To correct the problem, adjust the cell width.

Use the Number grouping to increase or decrease the number 
of decimal places shown. It is also possible to make number 
formatting choices such as currency.
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Adjust cell width

5e easiest way to adjust the cell width is to position your cursor 
between the column headings and drag the cursor to the point 
where you want the width of the cell to end. 

Alternatively, you can AutoFit the cell width to the longest entry by double-clicking between 
the column headings.

Check spreadsheets
It is important to always check your spreadsheet for accuracy. 5is may include double-
checking with your colleagues or manager to make sure the data you have entered is correct. 
As well as checking the values you have entered, you should also ensure that any labels are 
spelt correctly and that you have formatted all data to suit organisational requirements. 

Spreadsheet checks to carry out include:

• the accuracy of data entered

• that formulas are working correctly

• that all instructions have been followed

• the consistency of design and layout.

Check the accuracy of data entered

If the information contained in the spreadsheet is not accurate it will cause problems for 
others and reLect poorly on the company you represent. For example, you might mistype 
the <gures in a summary of house sale prices. Taking the time to check information and 
making sure it is correct helps to save time, improve o=ce e=ciency and increase the 
prospects of customer and organisational satisfaction.

To check errors in labels, select Spelling under the Review tab. 5is identi<es misspelt 
words. It cannot assist with product names, customers’ names or addresses. Manually check 
your spelling and crosscheck it with the documentation you used to enter the data. For 
example, you may have been given a printout of all customers’ names to be entered. Once 
you have entered the customers’ names, check them for accuracy against the printout.

You should check all information, including:

• name and address details

• spelling

• product information and pricing

• dates

• reference details; for example, catalogues and previous correspondence.
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Check formulas are working correctly 

When using formulas and functions, always make 
sure the result you get is the result you want. Test 
formulas and functions before using them in the 
spreadsheet. Do this using a calculator. Also check 
the consistency of information against the original 
data and check that cell references, operators and 
functions are correct. 

You may be able to give the information you produce 
to a colleague or supervisor to check in draF form 
before you complete the <nal version. 

Use the Show Formulas tool   on the 
Formulas tab to review formula entries.

Check all instructions have been followed

Producing spreadsheets requires you to follow instructions. Instructions may be given 
by your manager or supervisor, the person requesting the spreadsheet, past spreadsheets 
or instruction manuals. Instructions may relate to the spreadsheet’s content or its format 
and layout. For example, you may be asked to produce a sales report summarising weekly 
<gures, and provide a comparison of actual <gures with target <gures. You may be required 
to identify sales personnel and specify their performance in terms of actual and target 
performance. 5ese instructions provide guidance on what is required for the report and 
how it is to be produced.

If instructions are not followed, it may delay the <nal production of the report, or reduce the 
usefulness, meaning and credibility of the information. If you need to clarify instructions, 
or have your own ideas about how the spreadsheet could be improved, speak to your 
manager or the person requiring the information.

Ensure consistency of design and layout

Always check the design and layout of your spreadsheet conforms to your organisation’s 
standards. Consistency in design and layout makes a spreadsheet easier to read, ensures it is 
useful and meaningful and promotes the image of your organisation.
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Practice task 7

Here is a spreadsheet and the original information used to create it.

Customer accounts worksheet

Customer documentation

Customers Balance

Smith 55.00

Carter 4,000.00

Andrews 3,455.00

Phillips 3,000.00

Elliot 2,500.00

Franks 5,000.00

Luie 34.00

1. How many errors are in the worksheet?

2. What are the consequences of numeric values being entered incorrectly?

3. What should customer Smith’s balance be?

continued …
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… continued

4. Create the worksheet with accurate information. Save it to an appropriate location, and call it 

Customer Accounts.
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5ere are numerous techniques for improving the appearance of spreadsheets. Here are 
some examples of how formatting can change the appearance of a spreadsheet. Compare the 
two examples: the <rst has not been formatted and the second has.

Alignment on page 
When creating spreadsheets, it is best practice to begin your spreadsheet at the start of 
the spreadsheet in A1. What occurs, however, is that when you print the spreadsheet, the 
information begins at the upper leF of the page. 5is is reasonable for presentation of a 
longer report but if it is a shorter report, the spreadsheet will seem to be crammed into one 
corner.  Look at the following example of page alignment:

3B Format a spreadsheet
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Page alignment

To adjust the alignment so the information is centred in the page, follow these steps:

1. From the File tab, select Print, then select Page Setup at the bottom of the Settings panel

2. Select the Margins tab

3. Under Center on Page click Horizontally and Vertically 

5e Page Setup dialog box also provides a preview of your changes.



74
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU304
Produce spreadsheets

Use Page Layout view
Page Layout view is used to quickly and easily make adjustments to the worksheet. Page 
Layout view enables you to adjust layout and format data as appropriate. It is possible in 
this view to change the orientation of pages, adjust headers and footers, and adjust margins, 
column width and row height. 5is view includes row and column headers, and has a ruler 
for measurement. Page Layout view appears on screen as follows:

 Page Layout view can be accessed from the View tab on the Ribbon. Adjust margins 
by positioning the cursor on the margin line in the ruler so it is a double arrow and click 
and drag. 5e same process can be followed to adjust row height and column width. To 
adjust the header or footer, simply click into the entry and make appropriate changes. 
Orientation can be changed from portrait to landscape, and vice versa, by selecting the Page 
Layout tab and selecting the Orientation tab.

Add and delete columns and rows
Columns and rows can be easily added or deleted from your spreadsheet.

To add a new row, from the Home tab, select Insert from the Cells grouping. 
Choose Insert Sheet Rows from the pull-down menu. A new row will be inserted 
above the selection.

To delete a row or column ,select the down arrow on Delete from the Cells 
grouping. Choose the appropriate option (column or row) to delete.
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Use shortcuts 
Keyboard shortcut commands are useful for speeding up data entry and formatting 
processes. It is possible to create macros to make your own keyboard shortcut commands 
for common actions that you undertake, such as inserting a company logo. Many other 
keyboard shortcuts are available. 5ese are explained in Excel’s Help function .

Some of the common keyboard shortcut commands include:

• Ctrl+B to make selected cells bold

• Ctrl+I to make selected cells italic

• Ctrl+C to copy selected cells

• Ctrl+X to cut selected cells

• Ctrl+V to paste selected cells

• Ctrl+F to activate the Find function

Practice task 8

Open the spreadsheet called Customer Accounts you created in Practice task 7. 

 • Go to Print to see how the spreadsheet will look when printed. 

 • Adjust the page alignment so it is centred on the page both vertically and horizontally. 

 • Check with Print Preview.

 • Practise inserting and deleting columns and rows. Don’t save the changes you make. You can 

also practise changing cell widths.

 • Use the Help function to investigate keyboard shortcut commands available in Excel. Search for 

Excel shortcut and function keys. 

 • Practise using some of the shortcut keys to change the format of the spreadsheet.
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Formulas and functions are the heart of a  
spreadsheet. 5ey take your data and manipulate 
it in various ways to give the outputs needed.

If you have created a formula in one cell, and you 
want to repeat it in additional cells, it can be copied 
or you can use AutoFill. AutoFill is used to repeat 
sequenced information that is in alignment with  
the selected cell. Use the AutoFill handle   
to repeat the sequence of formulas and functions. 

Functions are a type of formula that performs more 
complex calculations. Perhaps the simplest of these to 
understand is the SUM function, which is a complex 
form of adding values from a range of cells together.

From the Home tab, the AutoSum icon  is within the Editing grouping. AutoSum 
enables you to add values automatically using the SUM function. Select a range of values 
that you want to calculate and click the AutoSum icon.

Test formulas and functions 
You must ensure that your spreadsheet is working properly. 

In complex spreadsheets, there might be several possible answers depending on the order in 
which calculations are carried out.

You should input test data and use a calculator to work out what answers your spreadsheet 
should give. For instance, if your spreadsheet is meant to give the average of <ve numbers 
in cells B1 to B5, then make up some numbers and put them in the spreadsheet. Add up the 
same numbers on a calculator, then divide by <ve to see if you have the same answer as the 
spreadsheet. If not, you have probably made one of the mistakes in the list below.

Examples of some of the things that can go wrong with formulas:

• Typing in the wrong cell reference in a formula (such as B11 instead of B1)

• Making a mistake when typing the formula (such as having a + instead of a *)

• Not knowing what a formula is meant to do and so using the wrong formula.

3C Use and test formulas and functions
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Error alerts

Excel has many features to help you identify errors. For example, an alert will appear if there 
is an inconsistency in a formula. Look at the following example:

If you select the cell with the alert, a help bubble will appear that explains the error that 
Excel has identi<ed.

5is alerts you about a possible problem.

If you <nd there is no error in the formula indicated in the warning message, you can 
choose to ignore the error. 5is will remove the green error Lag from the spreadsheet.
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Audit tools

From the Ribbon, choose the Formulas tab. Go to Formula Auditing for tools that 
investigate errors and determine what action needs to be taken to correct them.

Of particular use is the Show Formulas tool, which changes the view so you can see all the 
formulas in the spreadsheet. 

Another useful feature is the Trace Precedents tool, which shows a diagram of where the 
data in the calculations comes from. To use this tool, you <rstly need to select the cell that 
contains the error and then select Trace Precedents. 5e spreadsheet will show preceding 
connections, as in the following example:

It may also be necessary to consult with colleagues, your manager or the person who has 
requested the spreadsheet to con<rm the results of the formula. If the results don’t appear 
to be correct, take appropriate measures to check the entries. 5is includes checking 
calculations as well as source information. If you are still in doubt, seek advice from your 
manager or colleagues.

Use of absolute and relative cell addresses 
5e cells in an Excel spreadsheet are all relative to each other. 5is means that if you place a 
value in one cell and then move it, the values will alter as the cell collects information from 
other cells around it. For example, the totals you calculated for each of your columns may 
need to be moved to another part of the spreadsheet. However, if you move the totals values 
to another location, the values would alter as the cells are no longer reading information 
from the cells immediately above them. 5is kind of reference is called a relative reference.

5is can be very important if you shiF a formula, because you may need to decide if the 
cell references in it should stay the same (absolute references) or stay in the same relative 
position (for instance, always one cell above the formula).

To make the values remain the same wherever you place them in the spreadsheet, you need 
to make the reference absolute. Relative references change when you copy and move them 
and absolute references don’t. To make a cell reference absolute, you need to place the $ 
symbol in the reference. Look at the following example.

=C5+B5 is a relative reference.

=$C$5+$B$5 is an absolute reference.
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Practice task 9

In this exercise you are going to create a formula to calculate the values for the Pro�t column.

1. Create a spreadsheet named Warehouse Pro�t using the data below.

2. Create a formula to calculate the pro�t. You must use the cell references of the cells you want to 

use in your calculations and not the actual numbers in the cells; for example, =A3+B3 would add 

up the values in the cells A3 and B3.

 • Select D4, the �rst empty cell under Pro�t. Enter the formula =B4–C4. Use the following example 

to help you.

 • Press the Enter key to perform the calculation.

 • Once you have a calculation, use Fill to repeat the calculation in the remainder of the column.

 • Your worksheet should now look like the following example.

 • The tax values need to be calculated as 10 per cent of the pro�t. In E4 enter the formula 

=10%*D4 (this will give you 10 per cent of the value in D4).

Look at the following example to help you.

continued …
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… continued

 • Press the Enter key to perform the calculation. Fill the calculation down the column.

 • Select F4, the �rst empty cell under End Pro�t. Enter the following formula =D4–E4. This 

calculation subtracts Tax from Pro�t, giving you an End Pro�t value.

Use the following example to help you.

 • Press the Enter key to perform the calculation. Fill the calculation down the column.

 • Save your work.

3. Enter the following data into a new spreadsheet.

 • Calculate the January commission. Remember to use the cell references in your formulas and 

not the actual numbers (so use B3 and not 34,050 for example).

 • Save the �le as January sales commissions.

4. In this exercise you are going to use a function to calculate totals.

 • Open your Warehouse Pro�t spreadsheet. You are now going to use the SUM function to add 

totals for each column of your worksheet that has a numeric value.

 • Select cell B10. From the Formulas tab select the Insert Function button . You will see 

the following Insert Function dialog box. Highlight SUM and click OK.

continued …
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… continued

 • As you have selected a cell at the end of a column full of numeric values, the SUM function is 

going to add all of these values together. Number 1 shows the formula the SUM function will 

use to make the calculation and the formula result is displayed at the bottom of the dialog 

box. Click OK.

 • B10 should now hold the calculation of all Income values added together.

 • Select the cells C10, D10, E10 and F10 one at a time and use the SUM function to add 

the values of their corresponding columns. Your worksheet should now look similar to the 

following example.

 • Save and close your work.

5. Open the �le January sales commissions.

 • Use AutoSum to calculate the total of the January commissions.

 • Use the maximum MAX function to calculate the highest commission.

 • Use the minimum MIN function to calculate the lowest commission.

 • Use the average AVERAGE function to calculate the average commission.

 • Save your changes.

6. Open the �le January sales commissions. Practise using the Trace Precedents tool to check you 

have entered the functions correctly.
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It is inevitable that problems will arise when  
designing and producing spreadsheets. Fortunately, 
there are many resources to help you in overcoming 
them. Using the Excel Help function, training 
manuals and instruction guides may be useful. You 
may also need to seek further help from colleagues or 
managers. If the problem is still unresolved, you may 
need to seek specialist help from your organisation’s 
information technology staB.

Common problems
A common problem is not following the 
requirements of the job. Examples include not 
conforming to organisational standards or leaving 
out some inputs. 

5e following table shows other common problems that occur when producing 
spreadsheets.

Problem Example Action to take to correct 

the problem

Data entry  • Misspelling names

 • Incorrect �gure entry

 • Non-inclusion of information

 • Check spelling

 • Proofread and check 

spreadsheet data

Text �ows 

over or text 

truncates

 • Text entry �ows into adjacent cell

 • Adjacent cell contains data, text 

appears to truncate

 • Adjust column width

 • Apply text wrap to the cell

Text not in full 

view

 • Adjust row height

 • Adjust alignment of cell content 

to be aligned to the top of the 

cell

continued …

3D Overcome problems with spreadsheet 
design and production
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… continued

Problem Example Action to take to correct 

the problem

Number entry 

has too many 

digits

 • The number of digits is limited 

to 15

Date 

formatting not 

consistent

 • Adjust date formatting to the 

same format throughout

Date or time 

or a number 

displayed as 

###

 • Adjust column width

Cell alignment 

not consistent

 • Adjust alignment – vertical and 

horizontal

Result of 

calculation 

does not 

appear to be 

correct

 • Check formula or function inputs

 • Check data entry

Result of 

calculation 

appears with 

a #VALUE! 

alert

 • Alert appears when a cell 

containing alphabetical content 

is included in a calculation; 

check formula or function input

continued …
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… continued

Problem Example Action to take to correct 

the problem

Green error 

alert

 • Click on the green alert – a 

message will appear to explain 

the possible problem 

 • Investigate error, and make 

necessary corrections

 • Use the warning menu to make 

appropriate choices 

Investigation 

into possible 

errors in 

results 

needed

 • Use the Formula Auditing tools 

to track the formula – this can 

only be used if the formula has 

been input using cell references 

such as =A1+A2

Help resources you can use
Working with computer applications can be quite 
complex. 5ere may be times when you need to seek 
assistance. Excel has a built-in help function, but if 
you cannot <nd the answer there you may need to 
seek the advice of an experienced Excel user.
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Manuals

Your organisation may have task- or role-speci<c 
manuals to help you produce spreadsheets. 5ese 
manuals may provide guidance and assistance on the 
types of information a spreadsheet should contain 
or may specify the instructions to be followed for 
formatting and designing spreadsheets. Being 
familiar with the manuals used in your organisation 
will save time and increase your e=ciency when 
producing spreadsheets. 

Excel soFware comes with user manuals that 
describe the soFware features and provide step-by-
step instructions for carrying out diBerent functions. 
You can <nd manuals in paper-based and online 
formats. Look for paper-based manuals in your 
organisation or in your local library.  

You may have been to a training course to learn a particular computer function or a supplier 
may have instructed you in the use of a piece of equipment. Training courses usually 
provide a comprehensive set of instructions or notes that are worth keeping for future 
reference.

Online help

You can <nd information about MicrosoF O=ce applications on many diBerent websites. 
5ese oFen contain frequently asked questions and solutions to common problems. You can 
also download updates, tools and any <xes MicrosoF has developed for soFware problems. 
You may <nd the following sites useful.

• www.support.microsoF.com – 5is is MicrosoF’s main site for <nding help to solve 
problems for all MicrosoF products. You can ask questions online and download <les, 
including service packs, drivers and patches. 5is site also gives you access to the 
MicrosoF Knowledge Base, which oBers help for all aspects of problems that can be 
experienced when using O=ce 2013.

• www.o=ce.microsoF.com – 5is site provides resources for all O=ce applications. It has 
news and announcements and useful <les that you can download. If you are connected 
to the internet, you can open this site by choosing Help and ensuring you are connected 
to O=ce.com.

Tool buttons

Each time you move your mouse pointer over a tool 
button and leave it there for a moment, it will display 
a help tip that tells you what the button is used for. 
For instance, from the Home tab, move your mouse 
pointer over the Font tools. You will notice the help 
tip for the Font Color tool button.



86
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU304
Produce spreadsheets

Practice task 10

Read the case study, then answer the questions that follow.

Case study

Chinh works as an administrative assistant in a small manufacturing organisation. One of his 

tasks is to create Excel spreadsheets for his supervisor.

When creating spreadsheets Chinh often needs to use Excel Help to answer questions about 

software functionality. If he is unsure of a screen icon’s function, he presses Shift and F1 and 

points to the icon with his mouse.

Recently, Chinh attended a two-day Excel training course at a local community centre. Chinh 

kept the training booklet they handed out and stores it on his bookshelf. It has a handy index at 

the back for quick solutions to problems. He has also photocopied pages from various manuals 

he found around the of�ce and has placed them in a Help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be solved using the 

Of�ce Assistant. Chinh then uses Microsoft’s support website to �nd a solution, or he refers to 

the paper-based material he has gathered.

1. If Chinh experiences software functionality problems, where does he go for help?

2. Describe how Chinh uses paper-based manuals for help.

3. If you experience a software problem when creating a spreadsheet, describe the steps you 

should take to solve the problem.
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Summary

1. Spreadsheets should be consistent in design and layout.

2. Spreadsheet design and layout must adhere to organisational and task requirements.

3. Text, numerals, date and time, formulas and functions can be entered into a 
spreadsheet.

4. It is important to proofread and check spreadsheets to ensure accuracy of the end 
product.

5. Formatting options provide a means to improve the readability and design of 
spreadsheets.

6. Using formulas and functions for calculations is what spreadsheets are all about.

7. Formulas and functions allow repetitive calculations to be done automatically. All the 
user has to do is change the data.

8. Excel has a number of ways, such as error alerts, to identify possible errors in the 
worksheet.

9. 5ere are many ways you can get help including manuals, help desks and online 
support.
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5is learning checkpoint allows you to review your skills and knowledge in creating a 
spreadsheet.

Part A
Create the following two spreadsheet reports. Save them to an appropriate location and 
name them as shown. Use appropriate formulas and functions to create the summary 
<gures. Use the various soFware functions to assist you to produce them. Use any help 
resources available to you as needed.

Learning checkpoint 3 
Create a spreadsheet
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AFer producing the spreadsheet reports, write your answers to the following questions.

1. List the soFware functions that you used to format the spreadsheet.

2. What did you do to check that the formula and function calculations were correct?

3. What help resources did you use to assist you to overcome problems in the design and 
production of the spreadsheet?
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Part B
Read the case study. Write down or tell your trainer, your answers to the questions. 

Case study

Gabby works for a market research �rm as a research assistant in the product testing 

department. One of their recent projects has been to undertake a focus group to analyse 

and evaluate the possible launch of a new ice-cream into the marketplace. The spreadsheet 

summary results should have looked the same as the following example:

Gabby was required to do the following:

 • enter all result data using the prede�ned style (template)

 • use the AVERAGE function to analyse overall ratings.

Gabby was new to using Excel, and wasn’t sure how to access and use the style sheet. She was 

experienced in using the SUM function, but was not sure about the AVERAGE function. Gabby 

decided that she would produce a spreadsheet that contained all the relevant information 

and present that to the product manager – surely that would be enough for them to determine 

whether to release the product or not. Gabby’s spreadsheet looks like this:

continued …
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… continued

1. What mistakes has Gabby made in the production of the spreadsheet?

2. What should Gabby have done to proof and check the spreadsheet?

3. If Gabby thought there was a problem with the results of the calculations, what could 
she have done to check it?
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4. What should Gabby have done to <nd out about style and the AVERAGE function?

5. Produce the required spreadsheet for Gabby. Save it to an appropriate location and name 
it New product evaluation – ice-cream.

6. What soFware functions did you use to format the spreadsheet?
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A chart is a graphical representation of selected worksheet information. Charts are used to 
visually represent numerical data and make it easier to spot trends, highlight changes and 
compare <gures over a period of time.

5e type of chart you use will depend on the type of data you are analysing; for example, 
you might choose a pie chart to show a single set of data and a column chart to show 
multiple sets.

You must format a chart in line with organisational and task requirements. Formatting a 
chart improves the presentation and readability of the information.

In this topic you will learn how to:

4A Select appropriate chart type and design

4B Create charts

4C Modify chart type and layout
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When producing charts, it is important to follow both  
organisational and task requirements. An 
organisation may have a set preference for the type of 
charts it uses. For instance, it may prefer to use 
column charts as opposed to line charts because it is 
easier to analyse the information. An organisation 
may also use certain colour codes for the 
presentation of data; if this is the case, these rules 
should be followed to ensure consistency of image.

Task requirements can depend on a set of 
instructions and protocols in the production of 
charts. You may be asked to prepare a summary 
report of monthly sales as well as a chart. If this is 
the case, you need to produce two documents. If the 
policy is that a certain type of chart design is used for the production of various reports, you 
need to do this. 

If you have any suggestions for improving the readability and analysis of charts and their 
associated data, discuss them with your supervisor or manager.

Chart types and their features
If you are using an Excel spreadsheet, you will be able to display your data in a chart. 5e 
types of charts you can select include area, bar, column, pie, line and scatter. 

Charts are visually appealing and make it easy to see data and recognise patterns and 
trends. 5ey make it easier to absorb information at a glance. 

Example: chart

The following example shows the percentages of types of cakes sold in a bakery presented in a pie 

chart. It is easier to look at the cake shop data in a chart, rather than in the columns and rows of a 

worksheet.

Charts are linked to information contained in the selected cells. That means if the cell data is 

updated (for example, the value 45 changes to 88), the chart is also updated accordingly.

4A Select appropriate chart type and design
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Choose and design a chart
5e kind of chart you choose and its design should 
reLect your organisation’s needs. In this section, you 
will look at diBerent types of charts and consider 
some of their most appropriate uses.

Area chart

Area charts are used to demonstrate changes over 
time. For instance, they may be used to show and 
compare changes to sales over a given time. Area 
charts highlight total values across a time line. 

5e following example shows how yearly real estate 
sales <gures vary for diBerent outlets.



96
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU304
Produce spreadsheets

Bar chart

A bar chart displays information as a series of horizontal bars. 5ese charts are useful for 
comparing data arranged in columns or rows. Bar charts show the diBerences between 
individual items.

5e following example shows how monthly sales vary for diBerent departments of a 
retail outlet.

Stacked bar chart

Use a stacked bar chart to compare the values of individual totals to a total across categories. 

5e following example compares monthly department sales <gures, as well as the total 
overall amount.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

97

Topic 4
Produce simple charts

Column chart

A column chart has vertical columns and is useful for comparing separate types of data 
from a data series. 

5e following example shows how rainfall data can be used in a comparison.
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3-D column chart

If you prefer the 3-D look for your column chart, choose 3-D when making your chart 
selection.

Use a stacked column chart to compare the values of individual totals to a total across 
categories. 

5e following example compares monthly rainfall for Melbourne and Sydney, as well as the 
total overall amount.

Pie chart

A pie chart shows a data series in percentage segments. It is useful for showing data as a 
percentage of a whole. Pie charts are commonly used to show which products are selling or 
how much market share an organisation enjoys. 

5e following example of a two-dimensional pie chart shows the market shares of <ve health 
food companies.
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3-D pie chart

If you prefer the 3-D look for your pie chart, choose 3-D when making your chart selection.

Line chart

A line chart shows the movement of values in a data series using single or multiple lines. It is 
useful for showing how the values of a data series can change over a period of time. 

5e following example uses a line chart to show rainfall in Melbourne and Sydney.
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Scatter chart

A scatter chart is used to compare and arrange data to analyse the relationships of 
information. A scatter chart displays clusters and is commonly used for statistical 
comparisons. 

5e following example uses a scatter chart to display and analyse estimated sales and 
actual sales. 
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Practice task 11

1. Using this table of information, note what type of chart would be best for displaying the 

information and why.

Data to be included in a chart Type of chart used Reason

Percentage of actual sales for individual product 

items.

Plant sales for the week:

Tree  25%

Shrub  10%

Grass  15%

Flower  20%

Ground cover 30%

Comparison of pro�t for individual retail outlets 

compared with year.

Pro�t for years 1 and 2:

Outlet  Year 1  Year 2

Boronia  $45,900 $65,009

Maidstone $57,392 $65,328

Dingley  $45,922 $57,281

Doreen  $10,282 $45,829

Altona  $67,292 $56,291

Comparison of workplace hazards identi�ed in the 

organisation.

Month Factory Of�ce

Jan 17 2

Feb 15 4

Mar 15 5

Apr 12 3

May 9 2

Jun 7 2

A chart to show changes in workplace hazard 

identi�cation over a given period of time.

Month Factory Of�ce

Jan 17 2

Feb 15 4

Mar 15 5

Apr 12 3

May 9 2

Jun 7 2

continued …
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… continued

Read the case study, then answer the question that follows.

Case study

Juicy Fruits is a fruit supplier specialising in fruit baskets for corporate organisations. At the end 

of each month, a report is compiled tallying fruit supplied. Information reported on includes 

product type, number of products supplied and sales �gures. Julian Ali, the business owner, 

is happy with the reports but has realised that some of the supply coordinators are �nding 

the information cumbersome to interpret. Julian has decided that in addition to the reports, 

he would like to trial preparing the information in chart form – a chart that compares the 

supply data of each of the products. He believes that a graphical representation of the data 

will be easier for the coordinators to decipher and compare. As the administration supervisor, 

Julian has asked you to prepare an example of how the data would be presented in chart 

form. Julian has asked that you use bright colours in the charts as this complements the style 

and colour range of fruit types supplied by the business. He has also asked that you present 

the information in column form with product supply numbers and product types identi�ed in 

the chart. It is important that there is a heading on each of the charts to clearly identify the 

information that is being reviewed.

2. What are the organisational and task requirements for producing the charts?
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To create charts in your spreadsheet, the <rst thing  
is to know what data you want to present. 5e second 
is to know what you want to do with it – the purpose 
of the chart. 5en you can choose the most 
appropriate type of chart to use. 5e data to be 
presented in the chart is known as the data range. 
5is information may include text and numeric data. 
5e numeric data is what is represented in the chart 
and the text relates to the series (or group) of data.

Before you start to produce charts, become familiar 
with the terms used when referring to parts of 
a chart. 

5e following information explains the meanings of 
terms you need to know.

Axes

An axis is a line that labels the 

information in a chart according to 

the labels in the columns and rows 

of your spreadsheet. Axes (the 

plural of axis) provide a reference 

for measurement or comparison of 

the data in the chart. Most charts 

have a vertical axis (known as 

the Y axis) and a horizontal axis 

(known as the X axis).

Categories

Categories are the names that are 

placed along the X axis of a chart 

and are determined by the labels 

in your spreadsheet.

Data range

The data range is the selection 

of values you choose from a 

worksheet to place in a chart; for 

example, all the numbers in one 

row or one column of data.

Legend

The legend is the key used to 

identify the various data series. If 

you include the series labels from 

your worksheet, Excel will add 

these to the legend. Otherwise the 

legend will display series 1, series 

2 and so on.

4B Create charts
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Produce a chart
To produce a chart, you must <rst enter data into a worksheet. You then need to select the 
data you want to appear in the chart. Use the Insert tab and select the appropriate chart for 
the data that you wish to present. A chart is linked to the worksheet it is created from, so if 
you alter the data in the worksheet, the chart will be updated.

To produce the chart, choose the data that you want to present. Select the data by either 
clicking and dragging over it with the mouse, or clicking on the cell to select it and then 
using the Shi# key and arrows on the keyboard to select the data. 

5e following example shows what selected data looks like.

Example: choose and produce a chart

The type of chart you choose will depend on your organisational requirements. 

The following steps show how to produce a column chart.

1. Open Excel and enter the following data into a worksheet. Save the worksheet as ‘Company cars’.

continued …
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… continued

2. Select cells A4 to E9. This selection should cover all the labels and values. This selection has now 

become your data range. Do not include any blank rows or columns in your selected cell range.

3. From the Insert tab, select the appropriate chart you wish to display; for example, ‘Column’.

continued …
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… continued

4. The chart will now display as an object in your spreadsheet.

5. To move the chart to a separate sheet within the workbook, select Move Chart  from the 

Design tab. A dialog box will appear; select to place the chart in a new sheet  

and then name it appropriately (for example, ‘Cars by state’).

6. The chart will now have a separate sheet in the workbook. If you look at the worksheet names, 

you will notice that the chart now appears there.

7. If the data you want to include in a chart is not in adjacent rows and columns, use the Ctrl key to 

make multiple selections in different locations on your worksheet.

8. Trendlines can be added by selecting the Trendline tool from the Layout tab in Chart tools.
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Practice task 12

Create a spreadsheet, with the data below for Hemline Miller, showing sales, customer numbers and 

quantities sold. 

1. Create a column chart that compares the sales data. 

2. Create a scatter chart that compares customer numbers with quantity sold. 

3. Create pie charts for sales, customer numbers and quantity sold.

4. Save your �le as Hemline Miller January Report.
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When working with charts, it is important to  
understand how to make changes if they are 
required. You can improve the appearance and ease 
of understanding by using titles, axis labels, legends, 
colour and changes to layout.

Format your chart
Once you have created a chart, you need to format it 
to suit your organisational requirements and make 
it easier to understand. 5is may include formatting 
the data range, text and legend or adding a pattern 
to the chart area. Look at the following example of a 
chart and notice the diBerent components that can 
be formatted.

Each component of the chart can be formatted by selecting the item, right-clicking your 
mouse to display the shortcut menu and then making formatting choices as appropriate. 
You can also use the Chart Tool buttons.

4C Modify charts and layout
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Formatting your chart

Once you have created a chart you will need to format it to suit your organisational 
requirements. 5is may include formatting the data range, text and legend, or adding a 
pattern to the chart area. 5e following steps show how to format a chart.

1. Open the spreadsheet with your chart.

2. Click inside any of the data series columns. Right-click your mouse and select Format 
Data Series. You will see the following Format Data Series dialogue box.

3. Click Fill and select Gradient <ll, then choose a preset colour and click on Close. You 
will notice that the data now has a shade eBect in the chart. If you want to change the 
look to something diBerent, instead of selecting Gradient <ll, select Picture or Texture 
<ll, and select an appropriate texture. 

4. Repeat this process to choose Gradient <lls for the other columns. 

5. 5e Plot Area is the space behind the columns. 5e Chart Area is the space behind the 
legend and the chart labels. Right-click in the Plot Area and select Format Plot Area. 
5e Format Plot Area dialogue box will appear. From Fill, select Solid Fill and choose 
an appropriate colour. Click Close.

6. Right-click in the Chart Area and select Format Chart Area. 5e Format Chart Area 
dialogue box will appear. From Fill, select solid <ll and choose an appropriate colour. 
Click Close. 

7. To add a border to the Chart Area, right-click and select Format Chart Area. From the 
Format Chart Area dialogue box, select Border colour, choose Solid Line and make the 
colour black. Click Close.

8. To add a Chart title, select Chart Title and then Above Chart from the Layout tab.
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9. To add axis titles to the chart, from the Layout tab select Axis Titles, and add a 
horizontal title and vertical title.

10. To format the text in the Chart title, select the Chart Title, and use the formatting tools 
on the Home tab. 

11. To add data labels to the chart, select Data Labels from the Layout tab, and then select 
an appropriate position in the chart (such as centre). 

12. Format gridlines in the chart by right-clicking and selecting Format Major Gridlines. 
Select Line Style and choose a dashed line style. Click Close.

13. 5e chart should appear similar to the following example:
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Why format your chart?
You will need to format your chart to adhere to 
organisational and/or task requirements. Formatting 
the chart can also enhance presentation and the 
information’s overall readability.

Balance the time taken in preparing the chart with 
the required output medium. If you do not have 
a colour printer, or are not presenting the charts 
electronically, it will not be necessary to spend a lot 
of time selecting colours and so on. You will only 
need to ensure the font type and size is appropriate 
and that the chart is well presented.

All parts of the chart are separate components and 
can be formatted and adjusted as appropriate. To 
select a part of the chart, point and click to select 
it – then use the tool bar or right-click mouse shortcut menus to make appropriate changes. 
Formatting of the chart can relate to colour choice, using gridlines, adding borders, adding 
titles and labels, font size and type, and even changing the choice of chart type to be used.

Titles in a chart are separate objects and can be moved around and re-sized, by clicking and 
dragging with your mouse.

Modifying a chart
A chart may need to be modi<ed. 5is could mean changing the type of chart, changing the 
range of data to be displayed in the chart or changing the formatting of the chart.

Formatting changes are done with the Chart Tools or by right-
clicking in the Chart Area or Plot Area. Once you insert a chart 
into your worksheet, you will notice that two new tabs appear – 
Design and Format.

Design tools

Design tools allow you to change the type of chart selected, adjust the style and layout, 
alternate the view of data between row or column, and check or adjust the data selected.



112
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU304
Produce spreadsheets

Chart styles tools

Chart Styles can be used to change the colours used in the chart. 

Chart layout tools

Chart Layouts can be used to change the way the chart is set out.
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Data tools

Data tools can be used to change the data range or adjust the way the data is presented in 
the chart.

Type tools

Type tools can be used to change the type of chart presented.
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Layout tools

Layout tools allow you to add to and adjust the appearance of the chart by adding titles, 
labels, gridlines and so forth.
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Analysis tools

Use the Analysis tools to add a straight line to compare individual results to the average.

Background tools

Use the Background tools to format the plot area (right-click on area and select Format 
Plot Area).
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Axis tools

Use the Axis tools to add gridlines and axis information.
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Format tab

From the Format tab, use the Insert Shapes group to add shapes 
and text, and the Insert tab, Illustrations group to add pictures and 
online pictures.

Current selection tools

Use the Current Selection group to select the various components of the chart (such as a 
chart title) and adjust their individual appearance.
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Format tools

Format tools enable you to alter the general appearance of the chart such as colours, font 
type and font size.

Format tools enable you to alter the general appearance of the chart such as colours, font 
type, and font size.

For example, Size tools can be used to change the height and width of the chart, adjusting 
the overall layout. 

Arrange tools

Arrange tools can be used to display the selection pane, which enables you to hide or 
display charts in the spreadsheet.
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WordArt styling

WordArt Styles tools can be used to add eBects to the labels within the chart.

Shape styling 

5e Shape Styles group can be used to change the border image of objects in the chart.
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Practice task 13

Open the Hemline Miller January report document you created in Practice task 12. Format the 

charts (using bright colours, gradients and textures) to include relevant titles and labels as follows:

1. Column chart, include the title ‘January – sales’.

2. Scatter chart, include the title ‘January – customer numbers vs quantity sold’.

3. Pie charts, including relevant titles for sales, customer numbers and quantity sold, as well as 

data labels showing percentages of total.

Summary

1. A chart is a graphical representation of selected worksheet data.

2. Charts are visually appealing and make it easy to display comparisons, patterns and 
trends in data.

3. 5e type of chart you choose to display data depends on organisational and task 
requirements.

4. When you insert a chart, three Chart Tools tabs appear – Design, Layout, and Format.

5. Each component of a chart can be formatted and adjusted as needed.
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5is learning checkpoint allows you to review your skills and knowledge in producing 
simple charts.

Part A
1. Write a short paragraph for each of these chart types explaining the type of data most 

suited to each type:

• Pie

• Column

• Scatter

• Line

2. Use the data below to create charts as follows (save the spreadsheet to an appropriate 
location and name it Jim’s Booksellers – January sales comparison):

• Pie chart to show percentage achieved for individual sales consultants.

• Column chart to show target and actual sales <gures for individual sales 
consultants.

• Scatter chart to show clusters of actual with percentage achieved.

• Line chart to show a comparison of target and actual for individual sales 
consultants.

Learning checkpoint 4 
Produce simple charts
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To calculate the percentage in the last column you need a formula that divides the actual 
sales by the target sales, then multiplies that answer by 100.

Jim’s Booksellers 

January comparison – target sales �gures to actual sales �gures

Sales consultant Target Actual Percentage of 

target achieved

Amanda $80000 $71891

Geraldine $75000 $72910

Harry $68000 $62820

Jim-Bob $87000 $92192

Maureen $85000 $78282

Part B
Workplace learners can either complete this assessment using a spreadsheet with charts that 
has been produced in the workplace or they can use the instructions below to complete the 
assessment.

1. Open the spreadsheet Jim’s Booksellers – January sales comparison which you made 
in Part A. 
Format the charts as follows:

• Use the Design tab tools to make adjustments to layout and style. Make choices  
according to your preference.

• Add data labels to the pie and scatter charts.

• Add gridlines, as appropriate, to the charts.

• Format the plot area using a gradient, as appropriate.

• Add a shape to the pie chart to identify the highest-achieving sales consultant.

• Use WordArt Styles to format chart titles.

• Use Shape Styles to apply dark borders around the charts.

• Preview your charts before printing on individual pages.
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You must ensure you are producing quality spreadsheets and charts that adhere to 
organisational and task requirements. 5e <nal spreadsheet and chart must be thoroughly 
checked and proofed before completion to ensure the correct message and company image 
are delivered to the audience. Print previewing your spreadsheet and chart before printing 
can save time and ensure the necessary adjustments are made before you print.

When preparing spreadsheets and charts you must comply with the required time lines 
and job instructions. If you believe that either the time line or job instructions need to be 
altered, you should discuss this with your supervisor or the person who has requested the 
work. Many businesses have strict deadlines for completing tasks. Failing to meet deadlines 
can have an impact on other tasks and teams within the organisation. 

It is easier to access spreadsheets that have already been created by using appropriate <le 
referencing and saving options. Saving <les in the correct location is important as it ensures 
all interested parties can access the spreadsheet quickly and easily. It also saves time and 
improves on business e=ciency.

In this topic you will learn how to:

5A Preview, adjust and print spreadsheets

5B Meet data input time lines and quality requirements

5C Name and store spreadsheets and exit applications safely
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Previewing lets you check spreadsheet accuracy,  
layout, presentation, consistency and readability. It 
will save time and improve e=ciency. It reduces 
paper wastage.

When you are planning a spreadsheet task, you may 
think that designing and creating your spreadsheet 
is the biggest part of the job. Yet collecting, checking 
and entering the data can take a long time. 5is part 
of the process can cause delays, especially if you 
need other people to contribute data. 5e data that 
goes into your spreadsheet needs to be complete and 
accurate enough to give the desired results.

Because there are so many <les created in businesses, 
and because staB change, you need to give <les useful 
names and store them in the right location. 5is makes it easier for people to <nd them 
later on.

Part of the proo<ng process for <nalising spreadsheets and charts is to preview them before 
printing. Print Preview lets you check that the requirements originally speci<ed have been 
met and also allows you to check layout and overall appearance.

Preview and adjust spreadsheets
Previewing spreadsheets before printing is good practice and you should always do so. 
As mentioned, previewing lets you check spreadsheet accuracy, layout, presentation, 
consistency and readability. It will de<nitely save time and improve e=ciency. By not 
printing until you are certain the spreadsheet is ready, you will save paper, power and 
print toner.

Print Preview function

Print Preview shows the selected spreadsheet or chart. If there is a chart as an object in the 
spreadsheet it will appear as above. If, however, you have clicked on the chart object and 
selected it, Print Preview will not display the data, it will only show the chart. Excel assumes 
that if you have selected the chart only, that is all you want to print. If you want to preview 
both the data and the chart, ensure the worksheet is active and not the chart.

If the chart is a separate sheet in the workbook and not an object with the data, to preview 
the chart you will need to select the worksheet that it is contained in.

5e default option for Print Preview is to preview only the current worksheet in view. If 
you want to view the entire workbook, you need to select all worksheets. To do this hold 
down the CTRL key and press each worksheet name with your mouse before selecting Print 
Preview.

Be careful if selecting multiple worksheets. If you have a number of worksheets active at one 
time, any data that you alter and input will be repeated on all of the selected worksheets. To 
deactivate multiple selected worksheets, simply click on one worksheet name. 5is will then 
become the active worksheet.

5A Preview, adjust and print spreadsheets



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

125

Topic 5
Finalise spreadsheets

Print Preview

To preview your spreadsheet or chart, go to the File tab and select Print.

5e preview will be visible in the right-hand side panel.

Print tools

From the Print screen you can do the following:

• print the workbook, spreadsheet or selection

• enter the number of copies you want to print 

• select double-sided printing

• alter the orientation from portrait to landscape, 
choose the paper size, adjust margins and 
scaling.

Further Page Setup options are available by clicking 
on the link below the Scaling drop-down menu.
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Print tools

Below the Print Preview there are buttons which allow you to:

• view next and previous pages

• zoom in or out on the spreadsheet

• show margins of the document and, if needed, make manual adjustments by using 
your mouse.

To return to your Excel workbook, select the Back Arrow.

To preview margin settings:

1. Open a spreadsheet.

2. Preview the spreadsheet.

3. Use the Zoom button to view the data closer up.

4. Check the page orientation is set to landscape.

5. From the Page Setup dialog box select the Margins tab and centre the data horizontally 
and vertically.

6. Use the Show Margins button to preview margin settings.

7. Close the preview.

Print spreadsheets and charts
Before printing, you need to decide what it is you 
want to print – speci<c sheets, the entire workbook, a 
selection of data or possibly just a chart.

When printing charts, you need to consider whether 
you want to print the chart as an object in the 
spreadsheet or whether you want the chart printed 
on its own page.
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Print the active worksheet

1. Open a spreadsheet <le. 

2. Go to the File tab and select Print.

3. From Page Setup select Scaling of 135 per cent. Scaling allows you to adjust the size of 
the print-out, making it larger or smaller on the printed page.

4. 5e <rst drop-down menu under Settings identi<es what is to be printed and will show 
active sheets. From the drop-down menu you can choose to print the entire workbook 
or a selection of cells. Alter the printer that you are printing to if needed, and select how 
many copies you want to print. It is also possible to alter how the multiple printed copies 
are collated. When you are ready to print, click the Print button.
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Printing formulas

If you want to print formulas entered in a worksheet, 
go to the Formulas tab and select Show Formulas 
from the Formula Auditing grouping.

When in Print Preview, use Fit to in Page Setup to <t 
your worksheets on one page or a number of pages.

Print a selection from a worksheet

You may be dealing with a very large worksheet 
or your manager may have requested only some 
information from a worksheet. If this occurs you 
may need to print only part of a worksheet.

1. Open a spreadsheet.

2. Select the cells you wish to print.

3. From the File tab select Print.

4. From the <rst drop-down menu under settings choose Print Selection.

5. 5e preview should now look similar to the following example.

6. Click the Print button.

Print a workbook

To print an entire workbook comprising multiple worksheets, follow the instructions for 
printing a selection, but from the drop-down menu select Print Entire workbook.
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Print a chart

1. Open a spreadsheet <le containing a chart. 

2. Select the chart by clicking on it. Because this is selected only the chart will be 
previewed and not the data in the spreadsheet.

3. From the File tab, select Print. Your chart will be displayed exactly as it will be printed. 
Click the Show Margins button and manually adjust the leF and right margin by 
clicking and dragging with your mouse.

4. Notice that Print Selected Chart is automatically selected. Alter the printer that you are 
printing to if needed, and select how many copies of the chart you want to print. Click 
the Print button.

5. Save and close the <le.

You can adjust the size of the print-out by altering Adjust to more than 100 per cent of 
normal size in the Page Setup dialog box. Page Setup is available when you select Print from 
the File tab.
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Follow organisational requirements for printing

A workplace normally has standards for staB to adhere to when printing. 5ese could 
include using recycled paper when printing for the <rst time, which enables you to check 
a draF copy before printing the <nal copy. A workplace practice of using Print Preview to 
proof spreadsheets before printing can help to save paper.

Organisational and task requirements may specify things like the number of copies. You 
may be required to print a master copy and then use the photocopier to make additional 
copies. 5is is particularly important with longer spreadsheet reports and charts, as you 
may be able to use the double-sided copy option available on the photocopier.

When preparing to print you need to ask yourself the following questions:

• What do I need to print – workbook, active spreadsheet, selected data, chart?

• Did I preview before printing?

• If it is a draF spreadsheet, did I print on recycled paper?

• How many copies of the spreadsheet do I need?

• Should I use the photocopier for multiple copies?

Practice task 14

The following tasks require you to access the Hemline Miller January report you worked on in 

previous practice tasks.

1. Open the �le Hemline Miller January report.

 • Preview the spreadsheet. Check the appearance of the data and charts and make any 

necessary adjustments before printing.

 • Print one copy of the spreadsheet.

 • Close the �le.

2. Open the �le Hemline Miller January report.

 • Select cells A4 to B9 – this will select only the store and sales data.

 • Print only the selected data.

 • Close the �le.

3. Open the �le Hemline Miller January report.

 • Select the column chart only.

 • Print the chart.

 • Close the �le.

4. From your Hemline Miller January report spreadsheet, print out the Store and Sales columns. 

Adjust the size of your selection until it is 150 per cent of normal size.
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Getting the data ready and then entering it into your  
spreadsheet may actually be quite a signi<cant task. 
5ere’s little point in having a spreadsheet ready 
three days before a meeting if it is going to take a 
week to collect, check, enter and re-check the data.

5ere are some standard ways to help meet time lines 
for data entry and to meet the accuracy requirements 
for the particular task.

Meet time lines
Whenever you are given a work task, you need to 
plan a time line. A time line breaks the task into steps 
and details when each step must be completed.

Find out when the spreadsheet is required and enter the date in your diary. Identify and 
plan the task requirements to work out how long it is likely to take. Careful planning is 
necessary to avoid a last-minute panic. If you are developing a spreadsheet for someone else, 
always clarify exactly what is required; for example, are formulas needed and do you have 
to create a new column? If you have to write formulas, make sure you allot enough time to 
have them checked by your manager.

If you are relying on others to provide you with data, then you need to allow for this. You 
should plan on giving reminders and follow-ups so others do not delay the whole project.

Prepare a checklist

Preparing a checklist can help you plan a work task. Creating spreadsheets will become 
easier once you are familiar with your organisation’s requirements. Look at the following 
example of a checklist.

Task Deadline Requirements Completed

Create a 

spreadsheet 

for manager

Tuesday 

20 March

 • Collect the product data

 • Check the data

 • Enter the data

 • Proofread the data

 • Format the spreadsheet using organisation’s style 

guide

 • Create a new column named Interest

 • Write a formula to calculate 10 per cent of 

customers’ balances

 • Create a column named Sale Price

 • Write a formula to calculate the new sale price



5B Meet data input time lines and 
quality requirements
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Organisational time lines
You will oFen be required to meet speci<c deadlines in a workplace. You may be instructed 
by your supervisor as to the deadline for completing set tasks; for example, preparing a draF 
summary report by 2.00 pm. You may also have regular deadlines for common tasks such as 
on a monthly basis, creating a report of customers who are overdue in paying their invoices.

You may <nd you have conLicting work priorities and time lines. In these situations, your 
supervisor may be able to help you by suggesting ways to meet the deadline or they may be 
willing to adjust the deadline.

Achieve time lines
Using a diary system and a to-do-list can help you 
prioritise tasks and stay aware of the time lines 
required for set tasks.

If you are asked to complete a task, always ask 
what the deadline is. If you have a high workload 
at present, ask if the deadline is de<nite or able to 
be negotiated. In many cases, there will be room 
for negotiation. If it cannot be negotiated, explain 
to the person making the request, or discuss with 
your supervisor, your conLicting priorities. Try to 
work out a happy medium or see if they are able 
to oBer some additional assistance for you to meet 
other deadlines. Your supervisor may be able to pass 
some of your other work onto another colleague to 
complete.

Always ensure that the time line set is realistic and achievable and, if there are any 
problems, that you discuss these with your supervisor or the person who requires the 
spreadsheet.

Accuracy of data
5e quality of the outputs from your spreadsheets will depend on the quality of the data 
going into them. Remember ‘GIGO’ – garbage in, garbage out?

You must ensure that the data being entered is good enough to do the job required; for 
example, if the manager wants percentages to the nearest 1 per cent and your data is very 
rough, then the answers you provide may be meaningless.

Not only does the data have to be accurate enough, it also has to be entered accurately.
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Practice task 15

Read the case study, then answer the questions that follow.

Case study

Crystal works as an administrative of�cer for a local government agency’s conference 

and meeting centre. Her role involves coordinating the bookings for the centre, as well as 

maintaining an adequate supply of stock and resources for the centre’s clients. Crystal’s 

supervisor has asked her to produce a report by the end of the day summarising all the clients 

that have used the centre in the past 12 months, along with a chart that shows the percentage 

of their usage. Crystal, being quite easy-going, said ‘no worries’ and went about her daily tasks 

as usual. She allowed herself the last hour of the day to prepare the report and chart. When 

Crystal began preparing the report and chart, she realised that it was a much bigger job than 

she had anticipated. The current system provides information in a folder and is more of a paper 

trail of information. Crystal realised she needed a lot more time to compile the information for 

her supervisor.

1. What should Crystal do?

2. What could Crystal have done differently when agreeing to the deadline for the task?

3. How important is the data-gathering component of this task?

4. What does the task actually require Crystal to do?
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You need to follow any requirements of your  
organisation for naming and storing spreadsheet 
<les. 5is will make it easier for you and your 
colleagues to retrieve spreadsheets when needed. 
Some organisations have strict naming standards 
that must be adhered to, such as all project <les 
having to start with PRO. Another example is using 
product codes rather than descriptions. It is better to 
use a product code as this is individual, whereas 
there may be many products with similar 
descriptions, so it can become confusing. Find out 
the naming standards for folders and <les in your 
workplace or place of study.

When you have a spreadsheet stored in a folder, it 
must have a unique name in that folder. No two spreadsheets stored in the same location 
can have the same name. Excel will let you know if a <le with the same name already 
exists, and you will have to save the <le using an alternative name. If you are not sure of the 
procedures for saving and storing, ask your supervisor.

When closing Excel, always follow procedures and exit correctly. 5is ensures the data you 
have entered into the spreadsheet doesn’t become corrupted and unusable the next time the 
spreadsheet is used.

Name your spreadsheet
As well as placing folders and <les in the appropriate place, you also need to give them 
appropriate names. Naming methods need to be kept consistent, simple and meaningful. 
5e <le name you choose may include any combination of numbers or letters. Some 
characters cannot be used in <lenames, including: . , / \ * ? <. Appropriate naming 
conventions help people identify and retrieve <les.

When saving, Excel automatically adds a <le extension to your spreadsheet. 5e <le 
extension identi<es the type of program that the spreadsheet has been created in, and tells 
your computer system what program to use when opening the <le again. In Excel 2013 and 
2010, all spreadsheets are saved with the extension .xlsx. For earlier versions of Excel (that is, 
1997 to 2003), the extension is .xls.

Create a spreadsheet to be used by previous versions 
of Excel
Excel 2013 has some features that are not available in previous versions. If you are creating 
a spreadsheet that others need to access electronically with a version older than Excel 2007, 
you will need to work in compatibility mode. Compatibility mode turns oB some of the 
new features, which ensures that people working in older versions will have full editing 
capabilities.

To save a spreadsheet in compatibility mode, go to the File tab, select Save As, and select 
Excel 97-2003 Workbook in the Save As Type list. 

5C Name and store spreadsheets 
and exit applications safely
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Authorised access
Many organisations have protocols in place whereby 
you can only access those parts of the shared network 
that are relevant to your work or your department. 
Authority to access various parts of the shared 
network are provided by the organisation’s systems 
administrator. If you do not have access to a part of 
the shared network that you need access to, discuss 
this with your manager.

It is also possible to limit access to spreadsheets 
that you create by the use of passwords. Passwords 
are commonly used for spreadsheets that contain 
con<dential, private or sensitive information; 
for example, pro<t analysis or staB information. 
Passwords can be used to limit access to opening 
spreadsheets or to limit the ability to modify information in the spreadsheet. Follow the 
steps below to place a password on a spreadsheet to limit access to opening the spreadsheet.

1. Open a spreadsheet.

2. From the O=ce button, select Save As.

3. From the Save As dialog box, select the Tools button.

4. Select General Options from the available menu.

5. Type in a password to open (ensure the password you choose is one that you will easily 
remember), and select OK.

6. You will return to the Save As dialog box, select the Save button. (If an error message 
appears stating that there is already a <le with that name existing, do you want to 
replace existing <le? Select YES. 5is will override the current <le and replace it with 
one with a password.)

7. Close the spreadsheet.

8. Practise opening the spreadsheet. You will need to enter your password to open it.

Organisational policy for backing up >les
Many organisations have set procedures for the backup of <les. In many large organisations 
this is administered through the information technology department and is an automatic 
process. In this case, the only thing you need to do is save your <les to the appropriate 
network drive and folders.

In smaller organisations, it may be necessary for you to backup <les. 5is may be done on a 
daily or weekly basis. You may have to backup <les to CD or to another disk drive. If this is 
the case, check with your supervisor for the relevant backup procedures.

Backing up <les is an important practice as it helps to prevent the loss of documents and 
information, and is extremely useful if something happens to the network or computer 
system and you still want to be able to retrieve previous documents.

USB memory sticks are also useful for storing and backing up information, especially when 
you require a portable copy of the information.
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Organisational policy for >ling hard copies of 
spreadsheets
It’s common for spreadsheets stored digitally to 
also be stored in hard copy. 5is guards against a 
computer system failure. Hard-copy storage requires 
space and the establishment of a <ling system that 
uses consistent, simple and meaningful names, 
similar to digital storage.

Hard-copy spreadsheets must be kept up-to-date. 
Hard-copy spreadsheets need to be managed well 
since storage space is oFen scarce and valuable. Old 
or superseded spreadsheets must be destroyed on a 
regular basis. Retention schedules list the time frame 
that spreadsheets need to be kept before they can be 
destroyed. Spreadsheets without permanent value 
may be scheduled for eventual destruction. Find out 
what kind of hard-copy <ling system is used at your workplace or place of study.

Storage security
Information is a valuable asset in any organisation. How information is stored and the 
security measures used to protect it are central to an organisation’s procedures.

5e spreadsheets you create will usually be stored on a server that allows access to multiple 
users. A server is a computer that delivers information and soFware to other computers 
linked by a network.

To enable staB to log on to a server, the systems administrator issues each person with a 
username. 5e user must then create a password. Usernames and passwords:

• give users access to the information they require to complete workplace tasks

• allow users to have diBerent levels of access to information.

You may <nd that some of the spreadsheets you work with are con<dential. Ask your 
manager for your organisation’s policies regarding con<dential material.

Safeguard data
Data also needs to be safeguarded against accidental or deliberate damage. Data loss is 
usually caused by human error or system failure. Many organisations use a data cartridge 
or cloud-based solutions to backup information on a database. If any damage occurs to the 
server, or the premises, a complete information backup is available.

A server is made up of many <les and folders. Organising this information helps users <nd 
what they want. If you are saving information onto a server, make sure you know where to 
put it. Ask about your organisation’s policies regarding the storage and security of Excel 
<les. 5e following case study shows the importance of always backing up data.
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Exiting the application safely
AFer creating or modifying a spreadsheet, you need to exit the soFware application without 
causing damage or data loss. Data loss occurs when a computer program stops performing 
its expected function. OFen the program or even the whole computer may appear to ‘freeze’. 
All computer users will experience data loss at some time. Data may have been accidentally 
erased or corrupted and made inaccessible.

To exit the spreadsheet program, click the exit button , which is located in the top right 
corner of the window. If you have recently made changes to your spreadsheet, you will be 
prompted to save changes.

Here are some precautions you can take to prevent data loss.

Precautions to prevent data loss

Try to work on only one spreadsheet at a time.

Data loss can occur if someone else tampers with your work. If you are working 

on a spreadsheet at your workstation, you need to lock your computer or exit the 

application before leaving your workstation unattended.

If you need to work with multiple applications open, make sure you close 

applications that are no longer needed. This will help your computer work more 

quickly and will prevent data loss in the event of computer failure.

If your computer starts to behave in an unusual way, save your work and shut it down 

immediately and do not turn it back on until you get assistance.

Make sure your computer has an up-to-date anti-virus, anti-spyware and �rewall 

program to protect it against malware from the internet. Check also that it has the 

latest security upgrades.
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Practice task 16

Read the case studies, then answer the questions that follow.

Case study

Matthew works as an of�ce administrator in a large organisation. His duties include formatting 

reports and saving them on the server. He is also responsible for backing up the server at the 

end of each day. At the end of a busy day, Matthew had completed several reports for different 

departments within the organisation. He had to save each of them in a different location, 

and it took him a while to work out where they all belonged. He wasn’t sure if he had saved 

them all in the correct place. After this, he was running late and decided not to back up the 

server. The next morning, the reports that Matthew had saved were needed for an important 

board meeting. However, during the night a virus had infected the server, destroying all the 

information from the previous day.

Fred has retired from an organisation after working as an administrative assistant for 10 years. 

The areas Fred was responsible for were accounts and projects. The day after he retired, 

someone needed a �le that Fred had created and stored. The �le contained vital accounting 

information. It was discovered that Fred had saved more than 500 �les in a variety of folders 

and the �le could not be located. The folders had ambiguous names such as Folder1 and 

Folder2 and the �les had names such as august1.doc and march2.doc.

1. What would be the consequences if Matthew did not save some of the reports in the correct 

place?

2. Can you think of any consequences of not backing up data on the server?

3. Describe why Fred’s folder and �le naming system failed.

continued …
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… continued

4. Fred was responsible for two areas. What could he have done to make sure �les could be easily 

located?

5. Explain why folder and �le names should be consistent, simple and meaningful.

Summary

1. You should always preview your work before printing.

2. Make sure you have formatted, checked all formulas and functions and proofread your 
spreadsheet before printing.

3. Working within a designated time line means you must plan your work.

4. Collecting, checking and entering data can be a big part of the task.

5. It is possible to print a whole spreadsheet or parts of a spreadsheet. 

6. A chart can be printed on its own or as part of a worksheet.

7. You need to understand your organisation’s policies and procedures on saving and 
storing spreadsheets.
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5is learning checkpoint allows you to review your skills and knowledge in <nalising 
spreadsheets.

Part A
1. Using the data below, create a professionally presented spreadsheet and appropriate 

chart to compare daily rainfall for each year.

Rainfall in millimetres

2014 2015

1 January 23 34

2 January 25 41

3 January 34 42

4 January 37 20

5 January 42 23

6 January 19 24

7 January 20 33

2. Print your spreadsheet on one page – landscape page orientation, incorporating the 
chart as an object of the spreadsheet.

3. Save the spreadsheet to an appropriate location, and name it Temperature 10–11.

4. Use the checklist below to ensure that you adhered to requirements for <nalising your 
spreadsheet.

Task What to check for 

Data entry Accuracy of data input

Data formatting Formatted professionally – appropriate use of styles, colour, font 

type, font size, bold, italic, underline, borders, shading, alignment

Chart Chart inserted as an object

Selected chart meets analysis requirements

Formatted professionally – appropriate use of layout and styles, 

colour, labels, titles, borders

Save �le Saved as name: Temperature 10–11

Saved to appropriate �le location – drive and folder

Print Preview Print Preview to check data, layout and overall presentation

Landscape orientation

Spreadsheet data and chart on same page

Any required adjustments to content, layout, appearance made

Print Preview again

continued …

Learning checkpoint 5 
Finalise spreadsheets
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… continued

Task What to check for 

Print Print single page to selected printer

Exit Excel Exit Excel ensuring all work is saved appropriately

Adhere to task 

requirements

Followed instructions 

End result: One page print-out – spreadsheet data and chart, 

professionally presented

Meet designated 

time lines

Able to meet designated time line (one hour) or as negotiated with 

workplace manager

Negotiate extension to time line if needed

Part B
Write down your answers to the following questions:

1. What can you do to improve your speed and accuracy when working with spreadsheets?

2. Why is it good practice to preview before you print the <nal spreadsheet?

3. What tools and systems should you use to ensure that you meet time lines?
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4. What do you do to name and store your spreadsheets to ensure easy access in the 
future?

5. What can you do to prevent loss or damage to your spreadsheets?

Part C
Use the following data to create a professionally presented spreadsheet and chart that 
compares target stock supply with actual stock supply.

Save the spreadsheet to an appropriate location and name it Our O4ce 2 U – January 
stock supply.

Our Of�ce 2 U – January stock supply

Target vs actual

Product code Target Actual Percentage of target 

that was achieved

PC239 4000 4309

PC340 3000 2987

PC401 2500 1076

PC509 4300 4109

PC617 3800 4026

Include the following components in your spreadsheet:

• Header stating today’s date

• Footer stating the <le reference details

• Chart legend, chart title and axis titles

• Blue font, Arial, 10 point
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Make other appropriate formatting choices to ensure the spreadsheet and chart are 
professionally presented. 5ese should include:

• Landscape orientation

• Centring the spreadsheet on page – horizontally and vertically

Make sure you:

• preview before printing – print the spreadsheet and chart on separate pages.

• save to an appropriate location and name the spreadsheet Our O4ce 2 U – January 
stock supply

• exit the program ensuring that all <les have been saved as appropriate.
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